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Foreword

Gods

Program functions

How to Get
Started

This software has been developed to assist in the management of new or existing inventories
of your sign program. This program contains al the information that isin the Sign Standard
Manuals. To eliminate the most common problems and obstacles in maintaining a sign
program, the following goals were set:

- Reduce the time-consuming process of adding/creating new signs to an inventory.

- Eliminate or diminish paperwork created when updating an inventory for maintenance or
replacement.

- Allow easy access to any sign with any configuration in the inventory.

- Include a catalog which generates sign specifications as specified in the manual, eliminating
possible errors and/or modification of standards.

- Cdculate legends automatically and generate sign panel sizes.

The program consists of four individual sections each performing a specific function. First,
the Inventory is the default startup position. It will generate a hierarchical framework to store
the folders and the database, and keep track of the necessary links between the different parts
of the Inventory and other program parts. All other parts of the program must be accessed
through the I nventory using the “Transfer” menu (described later in more detail). Second is
the Catalog, containing over 90 different sign type configurations with generic sign layout
diagrams, listed in a hierarchical format to make selection easier. When selecting a specific
sign type, it will transfer to Specifications which generates the appropriate sign specifications.
Sign specifications can then be modified, within the restraints of the sign type selection, to
suit particular needs. Finally, the Order generates sign orders from the Inventory. Orders can
be exported and merged to combine orders at a district level.

If you have any comments, additions or suggestions, please send them to Debra Stokes, Sign
Manager Software Liaison, New Orleans District, ATTN: CEMVN-OD-T, P.O. Box
60267, New Orleans, Louisiana 70160-0267, 504-862-1344.

Best case scenario when starting your sign program is to do a physical inventory of all signs
currently installed on the project first. However, in the real world, most people get into Sign
Manager because they have to order signs. Y ou cannot order a sign that is not in your
inventory because the Orders section of the software uses that inventory as its database. This
is important to remember because any changes you make to a sign while in the Orders section
will be reflected in the inventory.

The tutoria will show you how to create an inventory. If you are in the situation were you
must order signs before doing to routine inventory, create the inventory with the signs you
need to order and add to it at a later date.



Chapter One

General Introduction
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Use of the
manual

I nstallation

Using Windows

Create a shortcut icon for
your desktop

Start the program

Think of Sgn Manager as afile cabinet. The entire cabinet is the district or “Level 1.” Each
drawer is an individual field project or “Level 2.” In each drawer are folders that are the areas
you create, e.g., each recreation area or, a specific area of alock. Thisis“Level 3.” Ineach
folder are individual pieces of paper; the signs that are found in that recreation area or portion
of the project. Thisis“Level 4.”

To become familiar with Sgn Manager, it is recommended that you read the first

chapter of the manual and take the step-by-step tutoria in Chapter Two before attempting to
use the program. It will be useful to have the Sign Standards Manual ready for reference, but
it is not required since help files (if installed) will supply al necessary information.

The manual has been divided into six chapters; first, a general chapter to become familiar with
the package. Chapter Two gives step-by-step instructions on how to move around in the
program, giving you an idea of what the capabilities and possibilities of the program are.
Chapters Three to Six discuss four separate program parts. Inventory, Catalog, Specifications,
and Orders.

Each one of these chapters includes a description of screen displays and menu commands for
that particular program section. Finaly, there are some Appendices at the end of the manual
for additional, detailed and technical information on specific subjects.

Also enclosed is an index (page 65) and glossary (page 2) to help you find information on
specific subjects quickly.

Important: This program creates and uses specific directory and file names and
configurations. Therefore, do not copy the program manually or in any way other than using
the provided installation program. Do not change the configuration, contents or file name of
the programs and system files that are copied or created in the new directories unless you are
using the Sgn Manager program. Otherwise, errors and possible irreversible damage to
inventory files may result.

The latest version of Sgn Manager is 2.2.2, dated 1993 and is on three 5%2 disks.

5Yadisks: At the DOS prompt: insert the supplied disk marked “Program Disk No. 1" into the
“A:" disk drive and type “A:install”. Follow the on-screen instructions to install the programs
and files on your hard disk.

3disk: the directions are the same as above except when the installation program asks for the
next disk. Just press <ENTER> and the ingtallation will continue.

Go to Start, Run and browse to the SM directory. Use the right mouse button and click on
SM.EXE. Select create shortcut. Click and a shortcut is created in that directory. Use the
right mouse button again to click on the shortcut. “Send” it to your desktop/

xSart up the program by typing “ SM” from DOS

Sgn Manager will run in Windows if your computer has enough memory. You can even
create a shortcut icon for your desktop. Check with your district IMO staff.
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When the program is run for the first time, a dialog box will appear, asking for the district
name and serial number. The cursor is now located in the first field named “District :”.

xType in your district name and press <Tab> or <Enter>

The cursor will jump into the next field. If you make a mistake typing and have already
proceeded to the second field, you can press the <Tab> key until the cursor is located again in
the first field. Correct the mistake and proceed to the second field by pressing <Tab>. The
cursor is now blinking in the second field. The serial number can be found on the flap of the
envelope in which the program diskettes were shipped. It must be entered exactly the way it
is found here or on the envelope. This number has one capital letter and uses four zeros.

District: Pittsburg District

Serial Nunber 2. 10E0001

ED T CANCEL

Sample screen appearance at initiation of the program.

Basics Never create asign using all capital letters for the message. This will cause you delaysin
getting your signs because UNICOR will return your order forms.

Sgn Manager is not in Windows format. This means you cannot use your mouse.
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Glossary of
Terms

active

CANCEL

Typeover Curs _r
Insert Cursor

- File ----
Qoen

d ose

Del et e
Edi t
Copy
Past e
Print
Secure

Alert box A box that appears on the screen to give a warning or to report an error
message. The warning is accompanied by a beep.

Arrow keys The four directiona keys on the keyboard that, when pressed, move the cursor.
Sometimes called Cursor keys. Notations for these keys are <Left>, <Right>, <Up>, and
<Dn>.

Backspace Key A key that moves the insertion point backward, removing the previously typed
character.

Button A push button-like image in dialog boxes where you designate, confirm, or cancel an
action. An active button is surrounded by a double lined box. An inactive button by a single
line box. To select a button, use the <Tab> key until the button is active (double lined box
with the cursor blinking) and press <Enter>.

Cancel button A button that appearsin adialog box. Pressing it cancels the command. A
shortcut is usually the <Esc> key.

Choose To pick a command, menu or file/folder. You often choose a file to act on, after
you’'ve selected a command. For example, select the “Open” command in the “File” menu and
then choose afile.

Command A word or phrase, usually in a menu, describing an action for the program to
perform.

Cursor The insertion point when editing or a highlighted item. When used for text entry, the
cursor can have two modes. The first is an insert mode where characters typed at the cursor
point are inserted. The second is an typeover mode where the character at the cursor point is
replaced by the keystroke. To toggle between the two modes use the <Insert> key. When
highlighting an item, the cursor indicates the subject of the desired action, command, etc.

Delete Key A key that removes the current selection or next character after the cursor point.

Dialog Box A box that contains a message requesting more information from you. A diaog
box can contain a field, button, selection or text. To move from item to item, use the <Tab>
key. Sometimes the message is a warning that you are asking the program to do something it
cannot do, or that you are about to destroy some information. In these cases~ the message is
often accompanied by abeep. To cancel adialog box, press the <Escape> key or select the
“Cancel” button. Compare to aert box.

Dimmed Command/File A command/file that appears gray rather than black/white is
unavailable/locked at the moment. In the example to the left, only four out of the possible nine
choices are available. In another example, a Leve 5 in the Inventory, the “Data’ menu titleis
dimmed. At thislevel, only one file is shown in the window and thus there is no data to sort.
Dimmed commands are updated automatically and cannot be modified. Dimmed files can be
(un)locked using the “ Secure” command in the “File” menu.

File Any collection of information stored on a disk in a document, a folder, or system file.
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Proj ect:

Proj ect
Nane

Field A rectangular boxed areain the dialog box where information can be entered or selected.
Usually preceded by aftitle to identify the entered information.

Folder A holder of files or other folders. Folders allow you to organize information in any
way you want. A district folder contains project folders. A project folder contains location
folders. A location folder contains signs.

Hierarchical file system Used to organize the information in the inventory and present the sign
types in the Catalog in an orderly fashion (see folder). For example, to select a symbol signin
the Catalog, you first select the “Recreation” menu, then the “Symbol” sub-menu and finally
the “Symbol Identification Sign”.

Highlight To make something visualy distinct from its background, usually to show that it
has been selected or chosen.

Hot Keys See “Quick Access'.
Keys All actua key strokes on the keyboard have been identified by this symbol: <Keystroke>.

Keyboard shortcut A keystroke that you can use instead of a cursor action to perform atask.
For example, pressing <F2> is the same as choosing the “Open” command from the “File’
menu. Shortcuts are listed in the key bar at the bottom of the screen.

Lock To prevent documents from being edited, discarded, or renamed.

Matrix box A box that contains a table of sign specifications for a specific sign type. The
matrix box is activated when editing sign specifications in the Specifications section of the
program. When specifications are linked to each other, the matrix box will be shown to select
a set of specifications. The specifications that are active for the opened file will be highlighted.
To move from item to item use the <Up> and <Dn> keys. To cancel a matrix box, press
<Esc> or select the “Cancel” button. Compare to dialog box.

Mat ri x

-AM -Spec- |-Panel Size- - HAGL- - Mount i ng- - Post - -Qy-
5" LU 05 " x 7.33" 0" ¥ ound " ox 4"

. 5" HDO- 05 |6" x 7.33" 60" G ound 4" x 4 1

. 75" ALU-05 |9" x 11" 60" G ound 4" x 4" 1

. 75" HDO- 05 |9" x 11" 60" G ound 4" x 4" 1
Viewi ng D stance: 25 Preferred (A): 0.8929" Preferred (M: 0.4464"
Sel ect ed : 14" Selected (A): 0.5000" Selected (M: 0.5000"

NEXT (014 CANCEL
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- File ----

Open

d ose

Del ete
Edi t
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Print
Secure

Menu A list of commands that appears when you select the menu title in the menu bar.
Pressing <Enter> while a command is highlighted or pressing the highlighted Ietter for the
command chooses that command.

Menu Bar The horizontal strip at the top of the screen that contains menu titles.

Menu Title A word or phrase in the menu bar that designates one menu. Selecting the menu
title causes the title to be highlighted and its menu to appear below it.

Numeric keypad The set of keys on the right side of the keyboard that |ets you move the
cursor when the <Scroll-Lock> is off.

Progression Box Indicates the progression of the command currently executed (printing,
exporting, etc.) Thisway you know that something is actually happening.

Quick Access To move quickly through the program, “Hot Keys’ have been added to select
menus, commands, “button” commands and files. The first three items usually have a red
highlighted letter that indicates the “Hot Key”. The first letter of each sign typein the
Specifications section is a hot key even though it is not red. Files do not have a highlighted
|etter, but can be active.

Save To store information from memory into afile. Information is stored in the file
automatically when editing or creating a new sign in the Specifications section. Here a* Save”
or “Save as” command must be issued to save the sign (changes). Before discarding a new or
modified sign, the program will ask you whether or not you would like to save the sign
currently in memory.

Scrollbar Vertical bar on the right side or bottom of the window, used to move the contents
of awindow, or alist in adiaog box, by using the <PgUp>, <PgDn> or cursor keys.
Scrollbars are automatically activated when more information is available than can currently be
displayed in the window/field. A “Scrollbar” is active if the “Scrollbox” is shown. These are
most commonly found in the Catalog section.

Secure See“Lock”.

Tab Key A key that, when pressed, moves the cursor to the next field, button or selection.
Title Bar The horizontal bar above the window that shows the name of the current file.

Tutorial A set of step-by-step instructions designed to teach you skills.

Window An areathat displays file contents on the screen. You view files through a window.
Y ou can open or close awindow, edit its contents and scroll through it.
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Screen display

Menu bar DOOO00000100

The screen is built up in four sections. The top line shows the menu bar containing the pull
down menus for that particular program section. To activate these menus, you can move the
cursor to the desired menu title and press the <Enter>, <Up> or <Down> key. The pull-
down menu will be displayed and a command can be selected. “Hot keys’ for menus and
commands are provided with highlighted letters (usually the first) in the menu title or
command. For example, pressing <S> or <s> is the same as choosing the “ System” menu
title. Keyboard short cuts for commands are listed in the key bar at the bottom of the screen.
For example, pressing <F10> is the same as choosing the “Quit” command in the “ System”
menu.

The second section is the title bar underneath the menu bar, which indicates the currently
opened file or active program section. File names consist of a path name, file name and
extension (CASM\PROJECTS\PROJECTS.INV).

The third section is the file window, varying from program part to program part. The
Inventory displays the inventory files. The Catalog lists al sign types with a generic layout.
The Specifications section shows specification and data files, and the Order section shows
order files. Some windows may have a “scrollbar” depending on the kind and quantity of
information displayed.

Finally the fourth section, a key bar at the bottom of the screen, indicates which (function)
keys can be used at a particular time for which command.

Title bar IO

Window 000000000

Summary Window OO110

Key bar 0o

Default settings

File Data View Transfer Uilities System Fl=Hel p
OOMOOOOOO00000d C:\ SM PRQJIECTS\ PROJECTS. | NV IDOD00000000000000
O Project DDIINIIDIDDOO0OO0J0 Fls OTotal OCOONODOmMP IS O
North Creek 01-22—1998| 4| 42| 25| o| 14| o| 3

O Level 2 ODIMMMMTIIOOO00000 Fls O Total OCOONOOD O P IS O

District : Pittsburgh 1 471 157 124 7 150 33
District

Proj ect

Location :

F1 Hel p F3 Edit F5 Summarize F7 Next F9 Pause Esc C ose F2
Qpen F4 Print F6 Fi nd F8 Previ ous F10 Quit &  Select

Sample screen appearance in Level 2 of Inventory.

Before taking the step-by-step tutorial, make sure your program has been properly installed.
For the purpose of this tutorial the following default settings will be used.
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Insert/overstrike

“OK” button command

X

CANCEL

Pause window

Hard disk drive where program isinstalled on: C

Program directory: \SM
Floppy disk drive: A

All text preceded by a bullet (X) and noted in Italic indicates an action to be performed by the
user. Follow these instructions closely and type words or commands exactly as noted.

Note: When entering information, you can toggle between “ Insert” and “ Overstrike’ mode by
pressing the <Insert> key. You can see the shape of the cursor change from a line (“ Insert”
mode) to a square (“ Overstrike” mode).

xType the correct program serial number to gain access to the Sgn Manager
The serial number is 2.10E0001 and is located on the original program disk label. These are
zeros, not O’'s. Typeit exactly asit is here.

To proceed you can do either of two things. Each dialog box has an active button, indicated
with double lines around its contour. Pressing the <Enter> key will execute the active button
command.

xPress <Enter> to execute the “ OK” button command, indicating that entry is finished

or

xPress the <Tab> key until the cursor is blinking in the button command. Pressing <Enter>
will then execute the button command

Similarly, if you would like to cancel a diaog box, simply press the <Escape> key, or position
the cursor on the “Cancel” button using the <Tab> key and press <Enter> to execute the
“Cancel” button.

After executing the “OK” button command, the copyright screen will appear. The next time
you startup, this will be the first screen displayed.

Note: If the current date is invalid (00-00-0000 or < 1990), you will be asked to enter the
correct date.

At any time during a session, you may see the Sign Manager pause window, displaying the
current program version, program section, and current time. This pause screen will be
activated after a certain period of time.

M nut es: 0.5

ACTI VATE CANCEL

Sampl e screen appearance of system Pause.
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This was unfortunately set to default at 0.5 minute. This will drive you crazy within the first
two minutes. | highly recommend you change it now.

To change the window activation time,

xMove the cursor to the “ System” menu by using the <Left> and <Right> cursor keys.
When the menu title is highlighted,

xPress <Enter>, <Up>, or <Down> to activate the menu.
The menu will be opened and the Pause command is the seventh (7th) command listed.

xMove the cursor to the command using the <Up> or <Down> keys and press <Enter> when
the command is highlighted, or type the hot key “ P” for the “ Pause” command.

The screen will display a dialog box with field indicating “minutes.”. Enter the appropriate time
you wish to use before activating the pause screen, and press <Enter>. To de-activate the
pause screen, enter a value of 0.

xPress any key to continue to return to normal execution.
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Chapter Two

Tutorial



Building an
inventory

Open district file

Level 2;
Project display

The Inventory will be shown on the first level. This first screen shows a menu bar with menu
titles, atitle bar displaying the current Inventory database path (CASM\PROJECTS)), a window
displaying the district folder with district name and quantity of signs, a summary window
(empty on Level 1) indicating the current level of the Inventory, and akey bar showing the
active keys and their specific use.

To manipulate files in the district (create, edit, print, etc.), you will need to open the district
folder to take alook at the enclosed files.

xTo do this, move the cursor in the menu bar to the menu title “ File” (shortcut= type “ F")

xActivate the menu by pressing <Enter>, <Up>, or <Down>
The “Fil€’ menu will display all commands relating to manipulating files/folders.

xSelect the “ Open” command to display all projects and press <Enter>
A short cut for thisis pressing the <F2> function key (listed in the key bar at the bottom of
the screen).

Opening the folder will take you to Level 2 of the Inventory. The screen will display a new
title bar of the file just opened (CASM\PROJECTS\PROJECTS.INV) and a corresponding
window displaying all projects (none, if it isthe first time Sgn Manager has been used). The
summary window has been updated; the level is upgraded to two and the district folder is
displayed. You are now ready to create the framework for particular projects. To show this
process, you will create atutorial project named “North Creek”. The project contains all
crucial sign types necessary to get acquainted with the program. The tutorial project consists
of avisitor center and boat ramp. After entering the sign inventory, you will create an order
and backup your files.

File Data View Transfer Uilities System Fl=Hel p
IENENNENENENNENEEE, C.\ SM PRQJIECTS\ PRQJECTS. | NV IENENNENENENEENENEE

OProject IMIMMMMMMTMII0O0O0O000O Fls O Total ODCOONOODOIMP OISO
| of of of of of o

O Level 2 DDIMOOO0O000J0 Fls O Total ODCOONOOD O P OISO

District : Pittsburgh District 1 0 0 0 0 0 0
Proj ect

Location :

F1 Hel p F3 Edit F5 Reports F7 Next F9 Pause Esc C ose F2
Qpen F4 Print F6 Fi nd F8 Previ ous F10 Quit ¢ Sel ect

Sample screen appearance in Level 2 of Inventory.
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Create a new project

Project name

Project file name

Open project file

Create new locations

xSelect the “ New” command in the “ File’” menu
A diaog box will appear asking for a project name and a file name for the document you are
about the create.

Proj ect:

Fi | enane:

NEW CANCEL

xEnter the project name (in this case type,“ North Creek” ) and press <Enter> or <Tab>
Since both fields have to be entered with information, the <Enter> key will not activate the
“New” button, but will jump the cursor to the next field.

xType the file name (in this case “ NCREEK" ) and press <Enter>

(File names will automatically appear in upper case, and are limited to alpha numeric
characters, no spaces allowed.) Before thefileis created, the current district will be checked
for duplicate file names. The document will appear in the window and the summary window
will be updated; the district folder will indicate that one (1) fileis currently resident. To create
the areas where signs are located, open the project file.

xChoose the “ Open” command in the “ File’ menu

If North Creek isthe only project in the district file, the program will automatically openit. If

there are more projects resident, you will have to select North Creek and press <Enter>. The

North Creek project is displayed in the window. The title bar now indicates the newly created
file “NCREEK.INV” and the summary window displays the project name “North Creek”. You
are now at Level 3 where area locations are created.

xChoose the “ New” command in the “ File’” menu
A dialog box will appear, asking for alocation and code name.

Locati on:

Code:
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L ocation name and
file name

Sort project file

Ascending, descending

Data menu arrow

Open location file

xEnter “ Visitor Center” for location and “ VC” for code name
(Code names will automatically appear in upper case and are limited to apha numeric
characters, no spaces allowed.)

Note: Never use “INV” for the code name.
Sgn Manager uses .INV to designate program files. If you use .INV also, the program will be
confused and will not work properly.

xPress <Enter> when finished
Thefileis created and displayed in the window.

x Choose the “ New” command in the “ File” menu and use the same procedure to create a
second location named "Boat Ramp” with file name “ BTR’

The summary window will now indicate that there are two (2) filesin the North Creek project.
Y ou will notice that the “Boat Ramp” file is inserted before the “Visitor Center” file because it
has been sorted according to the sort criteriain the “Data” menu.

xChoose the “ Data” menu by pressing “ D”

The menu will list six (6) different sorting criteria that can be used to arrange the locations in
the “Tutorial Project” folder. Once afile has been sorted, it will stay in that order until another
sort criteriais chosen.

xSelect the “ By Name” command, and press <Enter>
A dialog box will ask you in what order you would like to sort the data (ascending or
descending). Press“D” for Descending order. The two files will now be listed in reverse.

xChoose the Data menu again
You will see that an arrow is located at the beginning of the “By Name” sorting command.

This indicates the latest sorting command executed (if no arrow is shown, the file is sorted
alphabetically, the default criteria.)

By Date

By Sign Type

By Specification Code
By Requisition Nunber
By Sign Quantity

xPress the <Esc> key to return to the menu bar

xChoose the “ Open” command in the “ File” menu
The cursor will move inside the window highlighting the “Visitor Center”.

xPress <Enter> to select thisfile
The file will be opened and displayed in the window. The title bar now indicates
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“NCREEK.VC" as the file name, and the summary window is updated with the location name
and “Level 4”. At this point you have been building a framework to put signsinto. Once you
arein a particular area location, you can start entering and saving signs

Entering a new sign To enter signs, transfer to the Catalog to make a sign selection. Transferring can be done by
either choosing the “ Catalog” command in the “ Transfer” menu at Level 4 or 5, or as you will
now do, by selecting “New” in the “File” menu at Level 4.

Sign catalog xSelect “ New” in the “ File” menu
A dialog box will appear asking for atransfer to either the Catalog or Specifications section.

Transfer to: CATALCG

SPECI FI CATI ONS

ABORT

xPress“ C” for Catalog

The program will now switch to the Catalog section of the program. On the left side of the
screen, you will see pull-down menus and on the right, a display window with a generic layout
of the sign corresponding to the highlighted menu. The cursor is located in the first Category
menu, highlighting “Identification”. Follow the listing of signs on the map drawing on page to
enter signsin the inventory. The first sign is a directional sign with symbols located on the

highway.
Select sign xPress“ D” to select “ Directionals’ and press <Enter> to choose this category
category menu The selected category is highlighted and a second menu will appear, asking for aselectionin a
sub-category. The current sign type “Approach Roadway Directional” is highlighted and a
layout is displayed.
File Transfer System Fl=Hel p
EENEENENENNENNENNNNEENEN SMCAT. EXE OO OO OO OO
Cat egory O0000O000000000000  Di spl ay DOO000000O000000O0000000000000000000)

Directional

SubCat egory IIJ0COI0000T0
Approach Roadway Directional
Approach Roadway & Synbol s generic layout of sign

Proj ect Roadway Directi onal illustrated here
Synbol Directional

Sign Type IIITTO0000000000

APRDI R
F1 Hel p F10 Quit “-  Mve Hone PgUp Esc d ose
F2 Open Tab - ® Myve End PgDn ¢ Select
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Select symbols

Transferring to
Specifications

Enter default
specifications

Edit APRS-03

xSelect “ Approach Roadway & Symbols’ and press <Enter> to select this sign type
A third menu appears asking for the number of symbols on the directional sign.

xSdlect “ Three Symbols’ and press <Enter>

The cursor will jump to the symbol display window to allow you to select three symbols. The
first will be the boat ramp symbol. The current symbol category is“General,
Accommodations and Services’.

xPress the <Right> cursor key to move to the correct category page (Water Recreation)
Notice that the yellow marker on the scroll bar on the bottom of the window moves with the
pages and the menu on the left is updated.

xSelect the “ RS-054 Boat Ramp” symbol (or press “ B” as a shortcut) and press < Enter>
The symbol is added to the menu on the left and the next entry can be made. The second
symbol is“Hiking Tral”.

Note: If you make a mistake, you can backtrack using the <Esc> key.
xUse the <Left> cursor key to move to the “ Land Recreation” page

xSelect “ RS-068 Hiking Trail” and press <Enter>
The last symbol is“Canoeing”.

xMove right to “ Water Recreation”, select “ RS-079 Canoeing” and press <Enter>

With al symbols entered, the program will transfer to the Specifications section and load the
“APRS-0.SPC” specification file (see title bar on top of the screen). You are now in the edit
mode. The cursor will move inside the window, ready to customize the specs. Specs that are
highlighted can be changed; dimmed specs are locked and cannot be changed. Note that panel
size and maximum line length are not yet displayed because no legend has been specified.
These items will be updated once a legend has been entered.

Since thisis the first time you are using the Specifications section, you should customize the
default setting for manufacturer name and requisition number, if known.

xPress the <Esc> key to exit the “ Edit” mode
The cursor will return to the menu bar.

xSelect “ Default” in the “ File” menu and press <Enter>
A diaog box will appear with fields for manufacturer name and requisition number.

xEnter a manufacturer’s name (usually UNICOR). No requisition number is necessary right
now. Press<Enter> to activate the “ OK” button command when done
Now that you have customized the default, resume editing your sign.

xSelect “ Edit” inthe“ File’” menu and press <Enter> (the hot key is <F3>)

The cursor will jump to the next item that can be edited in this sign record. Notice that in the
key bar at the bottom of the screen, “F5” is active as “Default”. This will insert the default
information into this sign.

Chapter 2, Page 5



Insert default

Viewing distance

Preferred letter size

Choose substrate

xPress <F5> to activate the default setting
The items are updated in the window. Similarly, to clear these items you can press <F6>.

xTo check the viewing distance, move the cursor to “ VW Dist.:” under “ Installation” and
press <Enter>

The viewing distance diagrams specify the size of the legend typography appropriate for the
distance at which a sign is to be viewed. These diagrams can be found under “Help” or <F1>.
To determine the legend size for signs where reaction time is not a critical factor, use the
pedestrian viewing table. The vehicle viewing table is used for signs read from approaching
automobiles and incorporates reaction time and advanced sign placement locations. Since
viewing distance is directly related to letter size, enter the appropriate viewing distance for this
particular sign and its location.

xType* 175" and press <Enter>

xTo confirm the legend size, move the cursor to “ Size (A/M):” under “ Legend/Symbol” and
press <Enter>

The matrix window will appear with atable for all available letter sizes. The viewing distance
deemed appropriate is shown with corresponding letter size and margin size on one line. As
you can see at the bottom of the matrix, the preferred letter size would be 6.25 inches. Since
available letter sizes are rounded off to the inch, select the closest letter size.

Mat ri x
-AM - Spec- -Panel Size- | -HAG- - Mount i ng- - Post - -Qy-
4" HDO- 04 0. 000"x 0. 000" 60" G ound 4" x 6" 1
4" ALU- 04 0. 000"x 0. 000" 60" G ound 4" x 6" 1
6" HDO- 04 0. 000"x 0. 000" 60" G ound 4" x 6" 1
6" ALU- 04 0. 000"x 0. 000" 60" G ound 4" x 6" 1
9" HDO- 04 0. 000"x 0. 000" 66" G ound 4" x 6" 1
9" ALU- 04 0. 000"x 0. 000" 66" G ound 4" x 6" 1

Viewi ng Distance: 175 Preferred (A): 6.2500" Preferred (M: 3.1250"
Sel ect ed . 112" Selected (A): 4.0000" Selected (M: 4.0000"

NEXT (0.4 CANCEL

Substrates are the materials a sign can be made of. Most signs are made in either high density
plywood (HDO) or aluminum (ALU). A substrate is determines by the spec code.

xMove the cursor to the 6" letter size for HDO using the <Down> arrow
The corresponding viewing distance now indicates 168'. This viewing distance comes closest
to the preferred 175

xPress <Enter> to select this set of specifications
The new set of specifications isinserted. Now enter the sign legend.
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Enter alegend xMove the cursor to “ Message” using the <Up> or <Dn> key (*M” isthe hot key)

xWhen the message box is highlighted, press <Enter>

The message box will appear. Since you have aready identified the symbols, all you need to
do is enter the legend. Since you need a message with arrow left, you do not need to change
the arrow direction on the first line, but continue with the actual message.

Note: If desired, the symbols can be edited individually

xPress the <Dn> key to move to the second line; the first line is locked.
The cursor will blink on the second line.

Move to next line xType “ North Creek” but do not press <Enter>
The <Enter> key would activate the “OK” button command. To move the cursor to the
second line, use the following method.

xPress <Dn> and <Home>
The cursor now blinks on the third line.

xType “ Recreation Area”

Calculated line lengths for the first and second line are respectively 52.200 and 68.430 inches
for a capital letter height of six (6) inches. These are shown on the right side of the matrix
box.

xPress <Enter> to activate the “ OK” button command

The legend is now updated and specifications have been calculated.
Maximum rounded off legend line length = 68.25"

Panel size = 104.25" x 50.25"

Post size= 6" x 8"

Y ou have now customized the first sign record.

xPress <Esc> to exit the “ Edit” mode

Since the file has not been saved, notice that the upper left corner indicates “VC-000". This
will be the individual number for this specific sign. We are now located in the “Visitor Center”
folder, but this sign record has no number since it has not been saved.

Saving a new sign xSelect “ Save as...” inthe “ File” menu or press <F8>
The program automatically searches for the next number in line and will display thisin the
window. Y ou can manually enter a number, or have the program search for an entry using the
“Find Next Number” and “Find Available Number” button commands.

xPress <Enter> to select the “ 001" entry

The file will be saved and folders updated. The upper left corner now indicates sign ID
number “VC-001".
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Editing an existing sign

Transferring to
the Catalog

Select main
identification

Y ou are now ready to enter another sign. Since a similar sign is located on the opposite side of
the intersection, you can modify the current sign. This will not affect the file just saved in the
inventory.

xPress <F3> to edit the sign

xSdlect “ Message” and press <Enter>
Since only the arrow direction is different, thisis all you need to change on the first line of the

message.

xWith the cursor on the first line, press the plus (+) and shift keys at the same time.
A selection box appears that will alow you to change arrow direction.

Message with arrow left:
Message with arrow | eft 45°:
Message with arrow straight up:
Message with arrow right:
Message with arrow right 45°:
Next Message:

CLEAR | NSERT CANCEL

xSelect “ Message with arrow right:” and press <Enter>
The message box has been updated with the new arrow direction.

xPress <Enter> to activate the “ OK” button command
Since thisis all you needed to change, you can now exit the “Edit” mode.

xPress <Esc> to exit the “ Edit” mode
Do not “Save’ the sign since this will overwrite the exiting “VC-001 " sign file. Usethe “Save
as...” command instead.

xPress <F8> to “ Save As...”
The next number “002" is shown.

xPress <Enter> to select the entry
The window is updated with “VC-002". Now enter the next sign on the map.

xSelect “ Catalog” in the “ Transfer” menu
The program will switch back to the Catalog. The next sign to enter is a standard identification
sign.

xSelect “ Identification” and press <Enter>
A second menu appears for identification signs.

xSelect “ Sandard Identification” and press <Enter>
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Check viewing distance
Enter legend

Capital letter height

The program will transfer to the Specifications section and load the “ STANID.SPC”
specification file. The cursor will move inside the window, ready to customize the specs.

xPress <F5> to insert the default information

The viewing distance is currently 100". Thisiswhat you want so go on to enter the legend.
xSelect “ Message’

xWhen the “ Message” is highlighted press <Enter>
The message box will appear. The first and fourth line are locked (dimmed); they identify the
message.

Message: Primary:

Secondary:

xUse the <Dn> cursor key to move the cursor to the second line
The cursor will blink on the first character of the second line.

xType “ North Creek” on the second line
Y ou will now see a calculated line length of 17.760 inches. If you make a mistake, you can
use the <Insert> key to toggle between “Insert” and “ Overstrike” mode.

xUse the <Dn> and <Home> cursor keys to move the cursor to the fifth line
The cursor will blink on the first character of the fifth line.

xType “ Visitor Center” on the fifth line
Caculated line length is 10.175 inch for atwo (2) inch high capital letter.

xPress the <Enter> key

The message window has been updated, as well as the legend window.
Maximum rounded off legend length = 17.75 inch

Grid=1-1

Panel size=32" x 9"

xMove the cursor to legend “ Size (A/M):” under “ Legend/Symbol” to change the captial letter
height
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Save as

Transfer to Catalog

HRS-02 sign

xPress <Enter> to edit the specifications and the matrix window will appear
Currently indicated isthe 2" letter height for a wall-mounted sign.

Look at the viewing distance information and the selected viewing information. The preferred
A sizeis now 3.57".

xPress the <PgDn> key to display the next page

xChoose the 4", HDO-01, ground-mounted sign, by using the <Up> and <Dn> keys Indicated
panel size for 4" is 64" x 18",

xPress <Enter> to select these specifications
Again, al specifications are updated. The file is now edited for your specific needs and can be
saved using <F8>. Y ou can now create another sign.

xPress <Esc> to exit out of edit mode to the menu bar

xSelect “ Save As...” in the “ File” menu
The program will search for the next number “003" and display it in a dialog box.

xPress <Enter> to save the sign
xTo enter a new sign, select “ Catalog” in the “ Transfer” menu

Note: If you forget to save a sign you just edited, the program will automatically ask you if
you would like to save it before discarding it.

Save Changes to VG 000

YES NO CANCEL

At the entrance of the visitor center, an hours sign is located.

xSelect “ Recreation” and press <Enter>

xSelect “ Opening Hours” and press <Enter>

Sign “Format A” is highlighted in the menu and the scroll bar at the bottom of the display

window is activated.

xUse the <Right> key to move to “ Visitor Center, HRS-02" and press <Enter>
A menu appears at the left asking for the number of inserts you need.

xSelect “ Two inserts’ and press <Enter>
The cursor will jump to the display window.
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Check viewing distance

Remar ks box

Access an existing
data file

xSelect “ HRS 14" and press <Enter>
The menu is updated.

xSelect “HRS- 15" and press <Enter>
The specification file “HRS-A.SPC” will be loaded (see title bar on top of the window).

xPress <F5> to insert the default information
xChange the viewing distance from 25' to 50' and press <Enter>
xNext, move the cursor to “ Sze (A/M):” and press <Enter>

Look at the viewing distance information and the selected viewing information. The preferred
A sizeisnow 1.78".

xSelect a 2" capital /letter height with a substrate of HDO and press <Enter>
A 2" capital letter height provides enough viewing distance to meet the criteria of 50'.

xSdlect “ Message” and press <Enter>

xMove the cursor and change the hoursto “ 8:00 am” and “ 4:00 pm”, and press <Enter>
xYou can remove comments in the * Remarks’ section by selecting “ Remarks’ and pressing
<Enter>

The entire message area is now highlighted (selected).

xTo remove this message, simply press <Del>
The remark is erased.

Y ou can also add remarks as necessary to make notes about a sign, location, etc.
xPress <Enter> to exit the “ Remarks’ section and <Esc> to exit edit mode
xSave the sign as “ VC-004"

At the intersection near the boat ramp, you need an approach roadway sign similar to sign
VC-001. To savetime, let's modified this existing sign to create the new one.

xSelect “ Go to...” in the “ System” menu
A dialog box will appear. This allows you to load the inventory file for VC-001.

Sign |1 D Nunber:

SEARCH CANCEL
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Check viewing distance

Save as

Copy afile

xType“ 1" and press <Enter>

Thefile“VC-001" will be loaded. Since the new sign is located on a slower speed road,
reduce the viewing distance to 100 feet.

xChange the viewing distance from 175' to 100" and press <Enter>
xNext, move the cursor to “ Sze (A/M):” and press <Enter>

Look at the viewing distance information and the selected viewing information. The preferred
A sizeis now 3.57".

xSelect a 4" capital letter height with a substrate of HDO and press <Enter>
A 4" capital letter height provides enough viewing distance to meet the criteria of 100'.

xPress <Esc> to exit edit mode

xPress <F8> to save the sign as“ VC-005" and press <Enter>

Y ou have now entered al signs related to the visitor center.

xSelect “ Inventory” in the * Transfer” menu, press <Enter> and <Esc>

Y ou are now back at the same level where you left off: the “Visitor Center” at Level 4. There
are currently five filesin the Visitor Center folder. To review the signs just created, you can

inspect each individual sign specification record.

xSelect “ Open” the “ File’ menu or press <F2>
The cursor will move inside the window.

xSelect “ VC-001" and press <Enter>

Sign specifications for “VC-001" will be shown.

To “browse” through an area’ s folder, you can use the <PgUp> and <PgDn> keys.
xPress the <PgUp> and <PgDn> keys to review the contents of the Visitor Center folder

xWhen finished, press <Esc> toreturn to Level 4

Since “VC-005" is located closer to the “Boat Ramp” than the “Visitor Center,” you will move
this sign to the “Boat Ramp” folder.

xSelect “ Copy” fromthe “ File” menu
The cursor will move inside the window.

xSelect “ VC-005" and press <Enter>
Thefile is now copied and pasted in the buffer.

xPress <Esc> to return to Level 3
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xSelect “ Open” fromthe “ Fil€” menu or press <F2>
The cursor will move inside the window.
xSelect “ Boat Ramp” and press <Enter>

Paste a file xSelect “ Paste” from the “ File” menu
A dialog box will appear asking for an ID number.

Si gn Code: BTR-

PASTE CANCEL

xType“ 1" and press <Enter>

The file “VC-005" will be copied and given the new 1D code “BTR-001".
After pasting the file, delete the origind file in the “Visitor Center” folder.
xPress <Esc> to return to Level 3

xSelect “ Open” fromthe “ File” menu
The cursor will move inside the window.

xSdlect “ Visitor Center” and press <Enter>

Deleting afile xSelect “ Delete” fromthe® File” menu
The cursor will move inside the window.

xSelect “ VC-005" and press <Enter>
A message box will appear asking for a confirmation on the command.

Si gn Code . VG 005
Sign Type . APRS-3
Spec Code : HDO 04
St at us : Conpl i ant
DELETE CANCEL

xPress <Enter> to activate the “ Delete’ command
The file “VC-005" will be permanently deleted from the Visitor Center inventory.
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xPress <Esc> to return to Level 3
Summarize a folder To review the sign types in a particular folder, you can issue a “Report” command.

xPress <F5> and a dialog box will appear.

Prepare : TYPE REPORT

STATUS REPCRT

COST REPORT

ABORT

xSelect “ Satus Report” by using the <Tab> key and press <Enter> (“S’ is the hot key)

xSdlect “ Visitor Center” and press <Enter>
The cursor will move inside the dialog box. Here you can request a report for specific signs
between particular ID numbers, between certain dates or request al signs be in the report.

From I D No.:

To 1D No.

After Date :

Bef ore Date:

xTo select all the signs within the Visitor Center inventory, press <Enter>
A message box will appear showing a summary of al sign types available and all sign types
resident in the folder with their respective quantities.
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Access a
specification file

Transfer to
Specifications

Visitor Center

Range A
Peri od A

Si gns Found : 4

Conpl i ant : 4
Non- Conpl i ant :

On Order

Pr oposed

In Stock :

Total Signs : 4

PRI NT SAVE CONTI NUE

xAfter review of the window, press <Enter> to return to the menu/bar
Note: you can print the summary tile with the “ Print” button command

In the “Boat Ramp” inventory is one symbol identification sign for the boat ramp. You could
access the sign through the Catalog, but a faster way is to directly access the specification file.

xSelect “ Open” fromthe “ File” menu
The cursor will move inside the window.

xSelect “ Boat Ramp” and press <Enter>

xSdect “ New” in the “ File menu
A dialog box will appear.

xSelect “ Specifications’ and press <Enter>
A selection box appears asking for a specification file code.

Spec Fil e: AC- 000
APRDI R
APRS- 0
BLM A
BLM B
BLM C
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Preparing an
order
Replacing a sign

xPress“ D” to jump to “ DNG-00", move to “ DRSS-1" and press <Enter>
The file “DRSS-1.SPC” (Directional sign with one symbol) will load.

xChange the viewing distance to 50 feet

xThen select “ Sze (A/M):” and press <Enter>
The preferred margin (M) isindicated as 0.8929" for 50" viewing distance.

xSelect 1" margin (M) as the closest value and press <Enter>
We refer to margin height (M) for this directional sign since there is no legend size (A) to
compare the viewing distance to.

Sdlect “ Message” and press <Enter>

Message: Synbol :
RS- 000 Synbol Description
Hel vetica Bold Arrow, Direction

xMove cursor to the second line, type “ RS-054 Boat Ramp” and delete the rest of the line.
xMove the cursor to the fourth line and type “ Right”

xPress <Enter> to activate the “ OK” button command

xPress <Esc> to exit edit mode.

xSave the sign as “ 002"
All your existing signs have now been entered.

xSelect “ Inventory” in the “ Transfer” menu, press <Enter> and <Esc>
You should be a Leve 4.

Creating an order can be done many different ways. The two most common will be discussed
here.

First, there is the replacement order where an old sign needs to be changed or replaced. Let's
assume that the signs created in the “Boat Ramp” have been out in the field for eight
years and need to be replaced. First, create a duplicate sign record of the old sign.

xSelect “ Copy” fromthe “ File” menu
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Use of the asterix “*”

A new sign for
the order

Enter the default

Check viewing distance

xChoose the “ BTR-001" sign (APRS-3) and press <Enter>
Thefileis now pasted in the buffer.

xSelect “ Paste” fromthe “ File” menu

A dialog box will appear asking for a new ID number. Because this sign will eventually replace
“BTR-001,” it is given the same number, but an asterix (*) is added to the end.

Note: the asterix (*) is the only non-numeric, non-alphabetic character the program will accept
as an additional notation. Use this notation to identify replacement signs. The new and old
signs are listed in the Inventory next to each other and are easily identified.

Sign Code : BTR

PASTE CANCEL

xType “ 1" and an asterix (*) and press <Enter>
A duplicate file will be created with ID number “BTR-001*"

Another way of ordering isto create a new sign. Since you are still in the “Boat Ramp” folder,
add a boat ramp rules sign (BTR-01).

xOpen the “ Transfer” menu and pres“ 0" to go to the “ Orders section
xHighlight “ Recreation” and press <Enter>
xPress “ b” for “ Boat Ramp” and press <Enter>

xSelect “ BTR-01" and press <Enter>
Thefile “BTR-01.SPC” will load.

xPress <F3> edit the sign specifications
The cursor will move inside the window.

xPress <F5>
The default setting will be inserted.

We have determined our viewing distance is 25' so there is no change to make.
xNext, move the cursor to “ Sze (A/M):” and press <Enter>
Look at the viewing distance information and the selected viewing information. The preferred A

sizeisnow .8929". However, the smallest capital letter height allowed for thissign is 1.5" so
thisis what we will use.
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Creating the order
form

xPress <Enter>

xSelect “ Message:” and press <Enter>

Message: No Wake Zone 15.787
Idl e Speed Only 17. 242
Next nessage:
00 Hor sepower 16. 860
Nexi mum 10. 448
Next nessage:
No Swi mm ng 15. 023
or \adi ng 10. 942

NEXT (014 CANCEL

xChange “ 00 Horsepower” in the message window to “ 10 Horsepower” and press <Enter>
The panel size will be updated to 25.375"x 29.25".

Note: The BTR-01 panel size will only be calculated AFTER a message has been modified.
xPress <Esc> to exit the “ Edit” mode

xSave the sign as “ BTR-003"

Y ou have now completed your sign record entries for the new sign order.

xTo create an order, transfer to the Orders section of the program by opening the “ Transfer”
menu and selecting the “ Orders’ command

Here is the screen you see for the first time.

File Data Transfer Uilities System Fl=Hel p
EEEEEEEEEEEEEREEEE] C:.\ SM ORDERS\ DI STRI CT. ORD OOOOOOO00d

O Order Nunber 000000 Qy 00 Status OJJJOOIIIID Cost ($) 0O Manuf acturer

F1 Hel p F3 Edit F5 Report F7 Export F9 Pause Esc
F2 Open F4 Print F6 F8 F10 Quit ¢ Sel ect
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Default order

If thisis the first time you are using the Orders section, you will want to create a default order.
When this order is present in your file, every time you generate a new order, the default order
will automatically be used to insert your address, name, phone number, etc.

xCreate a new order by choosing the “ New” command in the File menu
A dialog box will appear.

O der: | |

Fi | enane: | |

NEW CANCEL

xType “ Default Order” for order number, “ DEFAULT” for file name and press <Enter>

xNote: For the default to work properly, this file name must be capitalized or the information
will not be transferred to any new order you create.

The default order is created and displayed. The status of the order is“Proposed” and there are
no signs listed in the file (quantity =0).

xOpen the order to display the cover page

File Data Transfer UWilities System F1 = Help
IDDOIODOOIO0OOO0O0000000d. €\ SMORDERS\ DI STRICT. ORD IDDO0O00000000000003
- Cover Page OIDOOOOOOOOCOOO0OOC0OOOO0OO0 OO OO OO0 OO0 OO0
ship to : St at us . Proposed
Manuf act ur er
Installed by
Prepar ed 0000000000000 Rerar ks  OO0000000000000000000000000003

By
Dat e
Phone :
0 Approved IDOOO00000001
By
Dat e
Phone :
0 Ordered OIOOOO0OOOJ0000000 0 Cost MO OO OO OO
By : Sign Price $0. 00 (0 signs)
Date : Installation : $0. 00
Phone : Shi ppi ng : $0. 00

Total Cost : $0. 00
F1 Help F3 Edit F5 Report F7 Export F9 Pause Esc O ose
F2 Open F4 Print F6 F8 F10 Quit é Sel ect
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New order

Orderscover
page

Adding signs
to the order

xEdit the file by using the “ Edit” command in the file menu
xEnter your address, appropriate names and telephone numbers
xWhen finished, press <Esc> twice to return to the first Orders screen

xCreate a new order by choosing the “ New” command in the file menu
The dialog box will appear.

xType “ 12345” for order number and the same for the file name (file name is limited to alpha
numeric characters, no spaces allowed) and press <Enter>
A new order is created and displayed.

xOpen this order to display the cover page
The status of the order is “Proposed.” All items edited in the “Default Order” have been
inserted in the new file.

xProceed to open the sign list by using the “ Open Sgn List” command
The sign list will be displayed without signs.

xTo add signs to the sign list, select “ New” fromthe “ File’ menu
A dialog box will appear asking you to specify the files you would like to search for.

Locati on

I D No.

Sign Type :

Spec Code :

Req. No : SEARCH
St at us : CANCEL

xPress the <Tab> key until the cursor isin the* Location” field and type "BTR’

Chapter 2, Page 20



xPressthe

Quantity of added
signs

Automatic status
change

<Enter> key

The file will now search for signs found in “Boat Ramp.” Once a match is found, it will
display the file and ask if you want to add it to the order or if you would like to search for the
next file.

xType “ A" for “ Add”
A diaog box will appear asking for the quantity of this sign you would like to order.

xType“ 1" and press <Enter>
Continue until you have dl the signs you would like, or until the window “No match found”
appears. Thisindicates that al files have been searched. All files added are now displayed.

xTo view the contents of a particular file, you may select “ Open” fromthe “ File’ menu

Note: Sgns added to the sign order list automatically receive the requisition number of the
order and status of the order (“ Proposed” or “ On Order”).

xWhen finished viewing, return to the order cover page by pressing <Esc>
You will notice that the quantity of filesin the “Cost” box has been updated.

xSelect “ Edit” from the “ File” menu
The cursor will move inside the window.

xChoose the “ Status’ field and press <Enter>
The dialog box will display three items.

St at us: Pr oposed EDI T
On O der
Recei ved
CANCEL

xSelect “ On Order” and press <Enter>

A progression box will appear and all files in the order sign list will now receive the “On Order”
status. After the program edits the sign list, a dialog box will appear indicating the enclosed
files (number of filesin the sign list), files edited (number of files in the sign list found and
modified), and files not found (number of filesin the sign list which could not be found).
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Encl osed files 4
Files edited 4
Files not found/edited : O

X

xPress <Enter> to continue
xPress <Esc> to return to the menu bar

xSelect “ Insert Prices’ from the “ Utilities” menu
A dialog box will appear.

From 1D No.:

To 1D No.

After Date :

Bef ore Dat e:

xPress <Enter>
All signs will have prices inserted if that sign type isin the interna price list

Another box will appear and tell you how many signs had prices inserted, how many prices
were not found, etc.

Note: Snce all these signs were custom signs, no prices were inserted.
xPress <Enter> to continue

xSelect “ Print” fromthe “ File” menu
A dialog box will appear asking if you would like to update the sign list?
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Process the order

Locking files

Unlocking files

Received order

Always answer “No.”

Another box will appear that allows you to determine whether you want to print a brief
summary or a detailed order and how many copies.

Move the cursor to Order with the <Down> key

xPress <Enter> to activate the “ Print” button command
A progression box will appear and al files in the order sign list will now be processed.

The cover page and summary will print after the sign list has been printed.

xFollow the procedures your district sign program manager has for processing your sign order.
xReturn to the first level of the Order section by pressing <Esc>

To prevent modification of sign orders that have been processed, and to prevent deletion
and/or modification of sign records referenced in the sign order list, secure the sign order by
locking it. (Since locking filesis a personal preference, it is your choice whether you do thisin
real like. Do it herefor practice.)

xSelect * Secure” in the “ File” menu

xChoose the file “ 12345" you have just processed

xPress“ A’ to lock “ ALL FILES' in your order
The order and al signs referenced in the sign order list will now be locked.

Once an order has been processed and is shipped, you can unlock the file(s), but it is not
necessary.

xSelect “ Secure” in the  File” menu

xChoose the file “ 12345" you have just processed
xNow unlock “ ALL FILES' in the order

All the signsin the order will now be unlocked.

Once you receive the order, you will want to change the status of these signs. Y ou could do it
sign by sign, but there is an easier way.

xSelect “ Open” inthe “ File” menu
xChoose the file “ 12345”

xSelect “ Edit” fromthe “ File” menu
The cursor will move inside the window.
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xChoose the “ Status’ field and press <Enter>
The dialog box will display three items.

xSelect “ Received” and press <Enter>
Since al the signs in this order have arrived, change the status of each to Compliant by
pressing <Enter>

After editing the status of al signs, you will return to the menu bar.

xPress <Esc> twice to exit the edit mode and return to the first level in Orders
This completes the ordering of signs in the inventory.

Bad<ing up To backup your inventory of signs, return to the Inventory.
xSelect “ Inventory” in the “ Transfer” menu
xPress <Esc> until you are back at Level 2 of the Inventory

xInsert a formatted blank disk in disk drive A:
Do not remove you floppy disk before pasting the file(s).

Copy the sign xSelect “ Copy” in the “ File” menu, highlight “ North Creek” and press <Enter>
inventory to The sign inventory for North Creek is now pasted in the buffer.
be backed up

xGo to “ System” menu and select “ Database” to access a hew location for the backup
Change the xType“ A" and press <Enter>
database A dialog box will appear asking for a new district name.

xType “ Backup” and press <Enter>
A new digtrict file will be created on the floppy in drive A:

xSelect “ Open” inthe “ File” menu
The district file will be opened.

Paste a copy of xSelect “ Paste” in the “ File” menu
the backup file A diadog box will appear asking for a new Project name.

xType “ North Creek Backup” for project name and “ NCBACKUP” for file name
A duplicate of North Creek sign inventory will be created.

Note: To prevent erasure of an existing backup inventory, the “ Paste” command will not allow
you to overwrite an existing inventory. Therefore, if you are backing up on the same floppy
for a second time, you have two options. First, if you would like to use the same name for
your backup, erase the existing backup inventory file on the floppy prior to copying and
pasting your new backup. Secondly, if you want to save your existing backup,
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Return to database

Quit

Using “Master”
files

simply name new one differently. You can keep track of your backups by numbering them
consecutively (Backup 1, Backup 2, etc.)

xSelect “ Database” in the * System” menu to return to the original inventory location
Your original startup path “CASM\PROJECTS\” will be highlighted.

Note: It is very important to return to the original inventory location prior to quitting Sign
Manager. There will be a big problem if you were to quit while located at another location
(A: for example). If you select “ YES' when asked if you want to return to the current file
position when quitting, the next time the program starts, it will search for the inventory on
drive A.. It's not there and you will panic. Where are my signs?! Don’'t worry. Select

“ Database” in the “ System” menu and type in “ C:\SM\PROJECTS\” to return to the proper
inventory location.

xPress <Enter> to select the original inventory location path
You are back in the origina inventory location.

This completes the tutorial session. The North Creek inventory and order files may be deleted
using the “Delete” command in the “File” menu. To quit the program you may:

xPress <F10>
A diadog box will appear asking if you would like to save your current position.

xSelect “ YES' if you would like to return to this position the next time you start up, or “ NO”
if you would like to start at Level 1.

When you are creating your inventory of existing signs or when you are entering signs for a
new location or project, you may use a time saving technique of creating your own master files
for a boat ramp, picnic area, etc. Since there will be some signs that are common to all boat
ramp locations, create a“Master Boat Ramp” file that includes al these signs. Y ou modify the
signs for your own use and store them on a floppy disk (or in another folder on the hard drive)
the same way you backup your files. You can create many “masters’ that can be used
whenever you enter new data. To retrieve your “master”, use the same technique as backing

up.

Make sure you are located in your sign inventory.
xSdlect “ Database” in the “ System” menu to access a new database location

xInsert your “ Master” disk which contains the “ Master” files you created in disk drive A:

xType“ A" and press <Enter>
Your “Master” files will be opened.

xChoose the file you want to copy and select “ Copy” in the “ File” menu
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The file will be copied.

xSelect “ Database” in the “ System” menu to return to the original database location
Your original startup path “'CASM\PROJECTS\"* will be highlighted.
Do not remove you floppy disk before pasting the file(s).

xPress <Enter> to select the original inventory location path
Y ou are back in the original inventory location.

xMove to the folder where you want to create a new file and select “ Paste” in the “ File”
menu

A dialog box will appear asking for a new name.

xType the appropriate name(s) and press <Enter>

A duplicate of your “Master” will be created. This file can now be edited to suit the needs for
that particular location.

After “Pasting” the “Master” files you may remove the floppy.
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Screen display

There are five levels of information in the Inventory, each level providing more detailed
information than the last. At startup, the Inventory will open up at the level last specified or, if
nothing is specified, level one. (Registering the last location and level is done automatically
when transferring to another program section, or when quitting in the Inventory.) Levels used
are:

level one: District listing
level two: Project listing
level three:  Location listing
level/ four:  Sign record listing

leve/ five: Sign record specifications

File Data View Transfer Uilities System Fl=Hel p
OO OO C. \ SM PRQIECTS\ PRQIECTS. | NV OO OO0

O Project DDIIIIIIOOO0O0000 Fis O Total OCOONOOD O P OISO

North Creek 01-22-1998| 4| 42| 25| o| 14| 0| 3
0 Level 2 DDIDDIDOOOO0DO00O000000 Fis O Total OCONONOODOOMOOP OOS O
District : Pittsburgh District 1 471 157 124 7| 150 33
Proj ect

Location :

F1 Hel p F3 Edit F5 Summari ze F7 Next F9 Pause Esc d ose

F2 Open F4 Print F6 Find F8 Previ ous F10 Quit ¢ Sel ect

Sample screen appearancein Level 2 of Inventory.

Thus a hierarchy of filesis established which gives a clear overview of the sign database. To
access sign record specifications at level five, you will need to open the folders in which the
fileislocated. First, open the appropriate project folder, then the location folder, and finaly the
sign. A short cut to a particular sign in the data base is the “Find” command to search for a
single file or files with similar criteria.

The current level of information is displayed in a summary window at the bottom of the

screen. It indicates the current level, opened files/folders and records located in the file, and
their particular status.
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File menu -File--—--
Qopen

d ose
New
Del et e
Edi t
Copy
Past e
Print
Secur e

Open command Opens the selected file/folder and displays its contents in awindow. If only one (1) fileis
<F2> present, the file is automatically selected, otherwise the cursor will move inside the window to
select afile. After selection of afile, the level will be updated and the file/folder will be listed in
the summary window.
Active levels one to four
Note If it seems that afile is missing in the window, make sure that you have
selected “All” Signsin the “View” menu. For example, if “Non-compliant” is
selected, only files matching that criteria, or folders containing files matching
this criteria will be listed in the window
Close command <Esc>  Closes the current file and returns to the previous level.
Active levelstwo to five
New command Creates a new file/ffolder as specified in the dialog window.
- At level one, the creation of a new file means creation of a new database, thus a dialog
window will ask for a new path name (see “ Database” command in the “ System” menu for

more information).

- At leve two, it will create a new project folder, with afile name of a maximum eight (8)
characters (no spaces).

- At level three, alocation folder is created with afile name of maximum three (3) characters
(no spaces).

- At levels four and five, a new sign is created and the program will switch to either the
Catalog or Specifications section of the program.

Active All levds

Note At levels four and five, you can also create a new sign by transferring to the
Catalog or Specifications section directly using the “Transfer” menu
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Delete command

Edit command
<F3>

Copy command

Paste command

Deletes the selected folder(s)/file(s) from the database. | f only one (1) file/folder is present, it
is automatically selected, otherwise the cursor will move inside the window to select afile.
Before actually discarding the file/folder, you will be given a brief description of the fileand a
choice of executing or reversing the command. Once afolder and enclosed files are deleted,
they cannot be retrieved; use caution when using this command. At level one, deleting will
erase dl datain the Inventory.

Active All levds

Note If afile contains locked files/folders or is locked itself (dimmed on the
screen), it cannot be deleted. To unlock afile/folder (and/or enclosed files),
select the “ Secure” command in the “File” menu.

Modifies an existing file/folder as specified in the dialog window. If only one (1) file/folder is
present, it is automatically selected, otherwise the cursor will move inside the window to
choose afile. After modification, the file will be sorted and will be inserted in the correct
location. At leve five, the program will transfer to the Specifications section to allow editing of
the sign specifications for that particular sign type.

Active All levds

Note If afile contains locked files/folders or is locked itself (dimmed on the
screen), it cannot be edited. To unlock afile/folder (and enclosed files),
select the * Secure” command in the “File” menu.

Puts the selected file(s)/folder(s)) in a buffer, ready to be used by the “Paste” command.
“Copy” and “Paste’ can only be used on identical levels; for example, afile copied on level
three can only be pasted on level three. The buffer will be erased after a“Delete” command is
executed.

Active All levds

Note Use this command to backup the entire database or parts of the database.
Refer to the tutorial for procedures.

Used in conjunction with copy. After afile/folder is copied in the buffer, it can be pasted
anywhere, provided it is on the same level (you cannot paste a location, level three, in adistrict,
level two).

Active All levels

Note Very useful when creating a new project or location. Use it to paste standard

files (boat ramp file, picnic file, campground file, etc.) After pasting a
file/folder, it can always be modified/edited to suit particular needs.
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Print command <F4>

Printout samples

Prints the selected file(s)/folder(s) as specified in the dialog window. [If only one file/folder is
present, it is automatically selected, otherwise the cursor will move inside the window to select
afile. Thefile/folder will print asit is displayed on screen. Print commands are;

Print

Fle

Partition

From
To
Copies
Active

Note:

- files, prints all sign specification records in the file/folder.

- overview, prints only a summary of enclosed files/folders and their individua
status. At levels one to two only.

- short, prints a one line summary of the sign specification.

- long, prints the entire specifications of the sign (two signs per page)

- on, prints only those files that meet the criteria as specified with the “View”
command of that particular file/folder. (If non-compliant is selected, only non
compliant signs will print.)

- off prints al records in the file/folders.

prints signs with ID number entered, and higher

prints signs with ID number entered, and lower

prints the specified number of printouts

All leves

To choose print commands, move the cursor to the command with the <Tab>
key and use the <Up> or <Down> key to select the command selection.

Print execution can be canceled by pressing the <Esc> key. Wait until the
current file is finished printing, after which normal program execution can
resume.

U.S. Army District: District name. Sign Overview u.s. District: D\sncmame (A) S\gn\nvemury US. Army District: District name(A) Sign Inventory
Corpsof Engineers 01-27-1998 corpsot Engmeaspro,ec( Project Nam ) 27-1998 Corps of Engineers Project: Project Name (A) 01-27-1998
Page1 Location: Loca\cr\Name (A) Page 1 Location: Location Name (A) Pagel
Name Code Fils Tota C N O P S 1.D. Type  Spec  A/M Panel Size Qty HAGL Page Installed LOG002
Sign Type :BTR-02 Page 5. Requisition  :12345
Project One PROJECT1 13 44 26 0 13 1 0 LOGO001 STANID HDO-03 3" 24x48 1 40" 7.2 05-15-97 SchCode HDO-03 By Debva okes  Manufacturer :Unicor
Project Two PROJECT2 24 248 354 57 45 11 0 LOG002 SWM-03 HDO-01 .75" 22x23 1 40" 6.5 05-15-97 Status  :Compliant Date :05-15-97 Install (ed) 08-25-97
Project Three PROJECT3 7 74 36 8 7 0 25 LOG003 BTR-02 ALU-03 2" 18x24 2 60" 5.3
Project Four PROJECT4 34 405 366 284 142 0 34 LOGO004 APRS-3 ALU-05 3" 6x12 1 40" 52 Legend Panel Ingtallation
LOG005 CMP-08 HDO-05 3" 5x12 1 40 7.8 06-25-96 AIM Size :22x11.25"  Mounting ‘Wall
LOG006 APRS-09 HDO-04 2" 12x28 1 60 32 Length 22 753 Qty 1 Post Size N/A
Tota 58 997 564 348 207 12 59 LOG007 SECNID HDO-09 2.5" 23x48 1 40" 7.2 05-15-97 Grid 3 HAGL :60" A
LOG008 TR-003 ALU-04 2" 24.25x25 1 40" 7.8 06-25-96 Color ‘White Color :CorpsBrown Vw Dist. 50"
LOG009 R4-09 ALU-04 2" 12x18 12 40" 7.8
LOGO010 DNG-04 ALU-02 4" 18x12 1 35" 6.5 05-15-97 Mmge S
LOOGll SLAT-3 HDO 07 2" 12.75x20 1 40" 7.11 I nclude* Campground Full” panel
G012 SWM-01 HDO-03 2 48x24 1 60" 6.5 05-15-97 (4) opuonauegenu
LOGOlS RS-034 RDW 012.5" 8x12 1 40" 6.5 05-15-97 4- September 30
LOG014 PRK-AC ALU-04 4" 6.25x20 1 40" 8.4 Cemps(e%w;mesie Typeface :HelveticaBold
LOGO015 SECNID ALU-03 3" 6x12 24 40" 7.2 05-15-97 14 Day Limit
LOGO016 APRS-3 HDO-05 3" 25x48 1 35" 82
LOGO017 BTR-02 ALU-09 2" 17x28 1 40" 7.8 06-25-96 LOG002
LOG018 WRN-11 ALU-01 3" 12x21 1 60" 7.8 06-25-96
LOGO019 FDI-1 HDO-09 4" 6x18 1 60" 6.5 Sign Type :BTR-02 Page 5.3 Requ\smon 112345
Spec Code :HDO-03 By :DebraStokes Manufacturer :Unicor
Status  :Compliant Date :05-15-97 Install (ed) 08-25-97
Legend Panel | nstallati
AIM 75" Size :22x11.25" Mountmg ‘wall
Length :22.753 Qy :1 PostSize  :N/A
Grid 3 HAGL :60" Post N/A
Color ‘White Color :CorpsBrown Vw Dist. 50"
asge Remarkd
Include " Campground Full” panel
A) upnunal legend
4- September 30
Cﬁnpsle$§300mlesn=_14 Day Limit
Sign overview Short sign record (one line) Long sign record (two per page)
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Secur e command

Data menu

All sorting commands

View menu

All viewing commands

Locks or unlocks a selected file. If only one file/folder is present, it is automatically selected,
otherwise the cursor will move inside the window to select afile. Used to prevent accidental
erasure or modification. You may secure asingle file or folder, or dl files located within the
folder. Secured files/folders or files located in a secured folder cannot be edited, deleted or
added to. To reverse the command, select the “Secure” command again.

Active All levds

Note Locked files/folders cannot be modified while in this application, it does not
prevent erasure of the file(s) once back in the DOS environment.

By Date

>By Si gn Type

By Specification Code
By Requisition Nunber
By Sign Quantity

Controls the display of files/folders in the opened file/folder. Data can be sorted
in ascending or descending order and by the criteria as listed in the menu. Display of afileis
“remembered” as last specified and indicated in the menu with an arrow.

Active levels two to four

Note The “Date” command refers to the creation/modification date of the file/folder
on levels two to three, and to the installation date on level four.

Al Signs
Conpl i ant Si gns
Non- Conpl i ant Si gns
»0n Order Si gns

Proposed Si gns
In Stock Signs

Controls which files are currently viewed in the window. Only those files that match the view
criteriawill be listed in the window. Display of afileis“remembered” aslast specified and
indicated in the menu with an arrow. The viewing status of an opened file can be quickly
referenced in the summary window below. The data in the file matching the currently selected
viewing criteriais highlighted, while those that do not are dmmed. For example, if the
“Compliant” command is selected, files that are compliant or folders that contain compliant
files are shown in the window; the data in the summary window under “C” will be highlighted.

Active levels two to four
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Transfer menu

Inventory command

Catalog command

Specifications
command

Orders command

Note If information seems to be missing in a file or folder, check the “View” menu.
If acommand other then “All” is selected, it may be that the missing
file/folder does not meet the viewing criteria and is not listed in the window.

-Transfer -----------
» | nvent ory

Cat al og
Speci fications
O ders

Transfers control to the Inventory of the program. The files that have been modified last will
be opened and displayed in a window.

Active All levels
Note If the command is dimmed, you are currently in the selected program.

Transfers control to the Catalog of the program to select a sign type. When creating a new
sign and transferring from Inventory to Catalog, make sure you have selected a location to
save the new sign into, prior to transferring to the Catalog (transfer at level four or five). If
not, you will not be able to save a sign in the Specifications section later on.

Active All levels

Note If the command is dimmed, you are currently in the selected program.

Transfers control to the Specifications section of the program to select a specification file.

When creating a new sign and transferring from Inventory to Specifications section, make

sure you have selected a location to save the new sign into, prior to transferring to the

Specifications section (transfer at level four or five). If not, you will not be able to save asign.

See the Specifications section of the program for more information on creating signs

directly through the Specifications section.

Active All levels

Note If the command is dimmed, you are currently in the selected program. The
easy way to enter anew sign isto first select a sign type in the Catalog, after
which the correct specification file is accessed.

Transfers control to the Order section of the program to generate or modify an order.

Active All levds

Note If the command is dimmed, you are currently in the selected program.
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System menu

Database command

Summarize command
<F5>

Calculate command

Find command
<F6>

Dat abase
Sunmari ze

Cal cul ate
Find .

Fi nd Previous
Fi nd Next
Pause

Qi t

About .

Selects the active Inventory database path. To access another Inventory database, type the
new path and the default will be changed. To import files from another database in your
database, use the same technique as described with “Backing up files’ in the tutorial (see page
23).

Active All levels

Note When changing a database path, the program will ook for an existing file, if
none is found, a new one will be created prompting for a new name. When
changing the database path, the new path is not used as the default start up
setting, unless the new setting is saved when quitting or transferring. The next
time the program loads, this setting will be used as your start up.

Summarizes the selected file/folder in sign types (approximately 51). The result is displayed in
awindow and can be printed after summarizing.

Active levels one to three

Note Summarize execution can be canceled by pressing the <Esc> key.

Allows for arecalculation of the entire database after a system crash, disk error, internal error
or power failure. Calculation of a database includes the quantity of enclosed files/folders, total
number of signsin the files, and quantity of specific sign status.

Active level one only

Searches for files in the database matching the specified criteria. Criteria can be as general or
as specific as you want. The program checks your entry with the file in the inventory for a
match. Thisway you can specify a search for ID Number 1, which will result in display of
signs 001, 012, 188, etc. Or you can search for a specific ID Number match: 001, which will
display dl signs with ID number 001. Search criteria are:

Location file name maximum three letter abbreviated location file name (BTR, PIC, etc.)

ID number sign ID code (1, 001, 10*, *, 012, etc.)
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Find next/previous
command
<F7>/<F8>

Pause command
<FO>

Quit command
<F10>

About command

Help menu

Sgn type sign type as listed in the matrix (STANID, APRDIR, BT R-01, etc.)

Sgn specification sign specification code (HDO-04, HDO, 06, ALU, etc.)

After and Before sign installation date; you may elect to see signs installed prior to a date
08 (select before), after a date (select after) or during a certain period
of time (using both after and before).

Active All levds

Finds the next/previous sign with the criteria as selected with the “Find” command <F6>.

Active All leves

Note To view al signsin an entire database, do not specify any criteria and perform
a search. The first sign will appear. To view the next sign, press <F7> and
the next available sign will appear. To view signsin a particular location (at
level five), it is faster to use the <PgUp>, <PgDn> keys.

Specifies the waiting time before the screen goes blank with the pause screen, displaying the
program version, section, and time. To return to normal execution, press any key.

Active All levels

Note To deactivate screen save, enter “0” minutes.

Pressing <F9>, activates the pause screen, not the “Pause” command.

Exits program to DOS. You may select areturn to your current position when starting up
again; in this case, select “YES’ when asked “ Save current file position”. If not, you will start
up a leve one.

Active All levds

Shows the startup screen with copyright notice.

Active All levels
---------- Fl=Hel p
CGener al
I nventory
Cat al og
Speci fications
O ders
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General command
<F1>

Inventory command

Catalog command

Specifications
command

Order command

Transfers control temporarily to a General help program. The program contains information
on sign types and their hierarchy, material specification codes, color codes, error codes, and
diagrams for viewing distances and footings. While in the help program, you may switch to
other available help files by using the <PgUp> and <PgDn> keys.

Active All levels

Transfers control temporarily to the Inventory help program. The program contains
information on commands and key words. While in the help program, you may switch to
other available help files by using the <PgUp> and <PgDn> keys.

Active All levels

Transfers control temporarily to the Catalog help program. The program contains information
on commands and key words. While in the help program, you may switch to other available
help files by using the <PgUp> and <PgDn> keys.

Active All levels

Transfers control temporarily to the Specifications help program. The program contains
information on commands and key words. While in the help program, you may switch to other

available help files by using the <PgUp> and <PgDn> keys.

Active All levds

Transfers control temporarily to the Order help program. The program contains information
on commands and key words. While in the help program, you may switch to other available
help files by using the <PgUp> and <PgDn> keys.

Active All levds
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Screen display

Filemenu

Open command
<F2>

Transfer menu

Inventory command

Catalog command

Thereis only one level of information in the Catalog. Sign types are selected by scrolling
through the menus at the left side of the screen. A generic sign layout of the selected sign is
shown in the display window. To make a selection, move the cursor to the desired category
and press <Enter>. The selected category will be highlighted and a sub-category will appear.
Make your selections until the desired sign type is shown in the window. Once asign type is
selected, the program will transfer to the Specifications section and the sign can be modified
and/or saved. To return to a previously selected menu, press the <Esc> key. The hierarchy of
sign displaysisidentica to the chapters and sections in the Corps of Engineers sign manual.

Note: screen display colors match sign colors as shown in the sign manual as close as possible.

However, screen colors may vary depending on the different hardware configurations used.
Warning signs (yellow sign panels with black legends) are shown on screen in reverse (black
sign panels with yellow legends).

Moves the cursor in the Category menu to select a sign type. Select the desired category and
press <Enter>. Continue selecting until the correct sign type is displayed. Program execution
will then automatically transfer to the Specifications section.

Active At menubar

Note: Press the <Esc> key to return to a previous level or the menubar. Additional
files are available if the horizontal or vertical scrollbars are highlighted. If you
cannot find a sign type, try using the <L eft> and <Right> cursor keys to
scroll pages from left to right, or use the Genera help file to consult the sign

hierarchy.
-Transfer ----------
I nvent ory
» Cat al og
Speci fications
O ders

Transfers control to the Inventory of the program. The files that have been modified last will
be opened and displayed in a window.

Active At menubar
Transfers control to the Catalog of the program to select a sign type. When creating a new
sign and transferring from Inventory to Catalog, make sure you have selected a location to

save the new sign into, prior to transferring to the Catalog (transfer at level four or five). If
not, you will not be able to save a sign in the Specifications section later on.
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Specifications
command

Orders command

System menu

Quit command
<F10>

Help menu

General command
<F1 >

All other commands

Active In Inventory, Specifications or Orders.

Transfers control to the Specifications section of the program to select a specification file.
When creating a new sign and transferring from Inventory to Specifications section, make sure
you have selected alocation to save the new sign into, prior to transferring to the
Specifications section (transfer at level four or five). If not, you will not be able to save a sign.

See the Specifications section of the program for more information on creating signs directly
through the Specifications section.

Active At menubar

Note: The easy way to enter anew sign is to first select a sign type in the Catalog,
after which the correct specification file is automatically accessed.

Transfers control to the Order section of the program to generate or modify an order.

Active At menubar

Stops program execution and returns to DOS.

Active Always
--------- Fl=Hel p
CGener al
I nventory
Cat al og
Speci fications
O ders

Transfers control temporarily to a General help program. The program contains information
on sign types and their hierarchy, material specification codes, color codes, error codes, and
diagrams for viewing distances and footings. While in the help program, you may switch to
other available help files by using the <PgUp> and <PgDn> keys.

Transfers control temporarily to the selected help program. The program contains information

on commands and key words. While in the help program, you may switch to other available
help files by using the <PgUp> and <PgDn> keys.
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Specifications



Screen display

Shows sign specification file (and database file, if editing an existing file). When an existing
sign file is accessed for editing, the specification file for that particular sign type is loaded and
compared to the existing file. The specification file determines what and how the database file
can be modified. Without a specification file, a sign record cannot be generated or modified.
Files in the Specifications section will show those items that cannot be edited in grey, and
those that can be changed in white.

When a new sign type is selected in the Catalog, the correct sign specification file is accessed
in the Specifications section. Depending on the type of sign, this specification file may be very
specific (BTR-01.SPC for a BTR-01 sign type) or genera (RS-000.SPC for arecreation sign
type RS-001 to RS-999)

Files can only be saved when alocation is selected (level four or five in the Inventory) prior to
transferring. The selected location code is displayed in the top left corner of the window (in
this case VC for Visitor Center).

After editing a sign, you can transfer back to the Catalog to select a new sign type, or return to
the Inventory. You will be asked to save the changes you made before another command is
executed.

File Transfer System F1 = Help
OOOOOO000000000. €\ SMSPECS\ STANI D, SPC OO0 0000
0 VG 003 D000 000000000 000000000d

Sign Type : STAN D Page : 5.5-7 Requi sition No.: 97-12345
Spec Code : HDO 01 By John Brown Manuf acturer : Unicor

St at us : Conpliant Date : 06-14-1994 I nstall (ed) 03-12-1987
O Legend/ Synbol OO0 0O Panel D000 0O Installation OO0
Size (AM : 2" Si ze : 32" x 9" Mount i ng : Gound
Length : 17.75" Qy 1 Post si ze 4" x 4"
Gid o 1-1 HAGL . 60" Qy o1

Col or : Wite Col or Cor ps Brown VW Di st . 25

0 Message [OIOOTTT Hel vetica Bl d 0 Remar ks  OO0OO0000O00000000000000000

Primary:
North Creek
\S;ecpndar)é:e 0 Cost OOINOOOO0OCOO00000O00000
Isitor Center Sign Price :  $0.00
Installation : $0. 00
Tot al Cost : $0. 00
F1 Help F3 Edit F5 Sign Nane F7 Save F9 Pause Esc
F2 Load F4 Print F6 Go to ... F8 Save As... F10 Quit ¢ Sel ect
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Filemenu

Load command
<F2>

Edit command
<F3>

Print
Def aul t

Opens adialog box with alist of all specification files. Specification files are named after the
sign type they refer to: BTR02.SPC for a BTR-02 sign type. Specification files can be either
specific, relating to a single sign type (for example, the BTR-01.SPC specification file for the
BTR-01 sign type), or generic, relating to multiple sign types (for example, the RS-000.SPC
specificetion file for al recreation symbol signs). Since generic files do not refer to a specific
sign type, they cannot be saved in the sign Inventory. Generic specification files have an
extension of -A (grid A), -B (grid B),-C (grid C), or 0 (zero number extension). They can,
however, be opened and you may browse through the file to review the specifications.

Note To quickly move through the specification list, you can type the first letter of
the file you are looking for. The program will look for the nearest file with a
name beginning with the keyboard entry. Y ou may also use <PgUp> or
<PgDn>.

Moves the cursor inside the window and allows you to change the specifications that are not
dimmed. To edit a specification, select it by moving the cursor to the desired location and
press <Enter>. If the criteria can be edited, one of the following windows will appear.

Matrix Box For selection of specifications that are linked to other criteria. Selection
occurs in groups of criteria. Shown is amatrix that highlights the current
selection. Selecting a group of specifications is done by moving the cursor
<Up> or <Down>. Also indicated in the matrix box is the preferred legend
height for the selected viewing distance. The selected viewing distance refers
to the distance calculated with the legend height currently selected

(highlighted).
Mat ri x
-AM - Spec- -Panel Size- - HAGL- - Mount i ng- - Post - -Qy-
.5" ALU- 05 6" x 7.33" 60" G ound 4" x 4 1
.5" HDO- 05 6" x 7.33" 60" G ound 4" x 4" 1
. 75" ALU- 05 9" x 11" 60" G ound 4" x 4" 1
. 75" HDO- 05 9" x 11" 60" G ound 4" x 4" 1
Viewing D stance: 25 Preferred (A): 0.8929" Preferred (M: 0.4464"
Sel ect ed : 14" Selected (A): 0.5000" Selected (M: 0.5000"
NEXT K CANCEL
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Edit command
continued

Selection Box

Message Box

Note

For selection of individual specifications. If ablank field is shown, any entry
isallowed. If aScroll window is shown, a selection must be made.

Spec Code ALU- 03

HDO- 05
ALU- 05
HDO- 06
ALU- 06

For editing sign messages. Lines displayed in gray are locked and cannot be
edited. Signs that have calculated messages will display the line length after
the line in the selected capital letter size. Directional signs have a special
format when entered. To calculate sign size correctly, first identify the
direction using the plus (+) and minus (-) keys, then enter the sign message.
No empty lines should be left between messages!

Message: Message with arrow | eft
North Creek 34. 800
Recreati on Area 45. 620
Synbol s :

RS- 054 Boat Ranp
RS- 068 H king Trail
RS- 079 Canoei ng

NEXT X CANCEL

Specifications that do not activate adialog box cannot be edited. To create
custom signs, you can select the “CST-01.SPC”, “CST-02.SPC”, or
“CST-03.SPC” specification file, or select “Custom Signs’ listed under
“Recreation signs’ in the Catalog. To create custom signs of particular sign
types such as industrial safety, hours signs, etc., select the desired sign type
and select the sign with the abbreviation -CS (Custom) after the sign type.
Thisis usually the first sign type shown in arange. Thiswill alow for a
custom legend for that particular sign type.
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Save command
<F7>

Save as... command
<F8>

Print command
<F4>

Default command
<F5>

Transfer menu

Inventory command

Catalog command

Specifications command

Order command

Saves the current file from memory in the Inventory database and updates links.
Note Active only if afileis aready saved or an existing file is edited.

Saves the current file in the Inventory and updates links. Selecting this command will initiate a
search for the next sign ID number in the location. This number will then be displayed in a
dialog box. You may change this number manually or by using the “Find Next Number” or
“Find Available Number” button commands.

Note Active if alocation file has been accessed in the Inventory (level four or five).

Prints the specification file currently accessed.

Allows you to enter a default for “By” (person entering information), “ Requisition number”,
and “Manufacturer”. While editing a sign you may enter these defaults, using the <F5> key.

-Transfer ----------
I nvent ory
Cat al og

>>Specifications
O ders

Transfers control to the Inventory of the program. The files that have been modified last will
be opened and displayed in a window.

Transfers control to the Catalog of the program to select a sign type. When creating a new
sign and transferring from Inventory to Catalog, make sure you have selected a location to
save the new sign into, prior to transferring to the Catalog (transfer at level four or five). |If
not, you will not be able to save a sign in the Specifications section later on.

Transfers control to the Specifications section of the program to select a specification file.
When creating a new sign and transferring from Inventory to Specifications section, make sure
you have selected a location to save the new sign into, prior to transferring to the
Specifications section (transfer at level four or five). If not, you will not be able to save asign.

See the Specifications section of the program for more information on creating signs directly
through the Specifications section.

Note If the command is dimmed, you are currently in the selected program. The
easy way to enter a new sign isto first select a sign type in the Catalog, after
which the correct specification file is accessed.

Transfers control to the Order section of the program to generate or modify an order.
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System menu

Database command
Goto command

Pause command
<F9>

Quit command
<F10>

Help menu

General command
<F1>

All other commands

Dat abase

Goto. ..
Pause

Qui t

Selects the path to search for specification files (files with a .SPC abbreviation).
Searches the selected location for specified ID number and loads it into memory.

Specifies the waiting time before the screen goes blank with the pause screen, displaying the
time. To return to normal execution, press any key.

Note To deactivate screen save, enter “0” minutes.

Pressing <F9>, activates pause screen, not the “Pause” command

Exits program to DOS.

-Fl=Help --------
CGener al

I nventory

Cat al og

Speci fications
O ders

Transfers control temporarily to a General help program. The program contains information
on sign types and their hierarchy, materia specification codes, color codes, error codes, and
diagrams for viewing distances and footings. While in the help program, you may switch to
other available help files by using the <PgUp> and <PgDn> keys.

Transfers control temporarily to the specified help program. The program contains

information on commands and key words. While in the help program, you may switch to
other available help files by using the <PgUp> and <PgDn> keys.
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Chapter Six
Orders



Screen display

Filemenu

Open command <F2>

Close command <Esc>

New command

There are four levels of information in the Order section of the program. The first level shows
alist of all orders generated and their particular status (proposed, ordered and received).
Opening an order will give access to the second level showing the cover page of the order.
Opening to the third level will give access to the sign order list. Lists are created by either
searching for a particular criteria, or importing sign lists from another sign order. Signs can be
viewed individually at level four.

File Data Transfer Uilities System Fl=Hel p
IENENNENENENNEEEEE C.\ SM ORDERS\ DI STRI CT. ORD IENENNENENENEEEEEEE

O Order Nunmber OO0 Qy OO Status OO0 Cost ($) OO Manuf act urer

F1 Hel p F3 Edit F5 Report F7 Export F9 Pause Esc
F2 Open F4 Print F6 F8 F10 Quit ¢ Sel ect

-File----
Qpen

d ose
New
Del et e
Edi t
Copy
Past e
Print
Secure

Opens the selected file and displays its contents in a window. If only one file is present, the file
is automatically selected, otherwise the cursor will move inside the window to select afile. At
level two, order cover page, the open command will open the file containing alist of signs
included in the order.

Active levels one to three

Closes the current file and returns to the previous level.

Active levels two to four

At level one, it will generate a new sign order as specified in the dialog box. At level three, the
sign order list, it will initiate a search for one or more signs in the Inventory database by

criteria as specified in the dialog box. Only those signs that are in the database can be
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Edit command <F3>

referenced in the sign order list. The database referenced is the database currently specified in
the Inventory. Sign lists created only reference existing signs, they do not duplicate the signin
the database. Therefore, signs deleted in the Inventory database cannot be referenced and will
not print. To prevent signs from being deleted in the Inventory database, you can select
“Secure” in “File” menu and lock “ALL FILES’ in the sign order. Fileslisted in the sign order
will then be locked. To make sure you retain a copy of your order, including the database
files, you can “Export” the order on afloppy disk. See “Export” for more information on
duplicating orders. Search criteriain the dialog box are;

Location maximum three letter abbreviated location file name (BTR, SL, PIC, etc)
ID. No.  sign identification code number (1, 001, 10*, *, 012, etc)

Sgn Type sign type as listed in the matrix (STANID, APRDIR, BTR-01, etc)

Soec Code sign specification code (HDO-04, HDO, 06, ALU, etc)

Reg. No. requisition number of the sign type (sign order number)

Satus sign status (compliant, non-compliant, on order, proposed, in stock)

After searching and finding a sign matching the criteria, it will be listed in a dialog box where
you can elect to add it to the sign order list or search for the next sign. When a sign is added
to the sign order list, it will receive the same status as the sign order (“Proposed” or “On
Order”), and the sign order requisition number. Before asign is added to the list, you must
enter the quantity of the particular sign type you would like to order. Quantities can be edited
at any time using the “Edit” command.

Active levels one and three
Modifies an existing order as specified in the dialog window.

- At level one, modification of the sign order requisition number will initiate a search of files
listed in the sign order list and edit the requisition number in the sign file.

- At level two, the cursor will move inside the window and you can edit any item listed. Move
the cursor to the desired item using the cursor keys and press the <Enter> key. The only
item that cannot be edited is the quantity of signs, which is calculated automatically when
adding or subtracting signs to the sign order list. When editing the status of the sign order at
level two, a powerful feature will be activated. If the status of the order is changed to “On
Order” or “Proposed”, dl signs listed in the sign order list will receive the same status.
However, when the status “Received” is selected, each sign in the Inventory can be assigned
an individual status. Each sign will be listed in a dialog box and you can assign the particular
sign status, depending on whether the sign order is processed, received or installed.

- At level three, the edit command allows you to modify the quantity of a particular sign on the
list.

Active levels one to three
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Delete command

Export command <F5>

Import command <F6>

Print command <F4>

Note If afile contains locked files/folders or is locked itself (dimmed on the
screen), it cannot be edited. To unlock afile/ffolder (and enclosed files),
select the “ Secure” command under the “File€” menu.

At level one, it will delete the selected order and sign order list of that particular order. At level
three, it will delete the selected file from the sign order list. The sign itself will not be deleted,
only the listing in the sign order list. Once a order is deleted, it cannot be retrieved; use caution
when selecting this command. If asign order is accidentally erased, the actual sign order list
can he recreated quite easily by searching the database for signs with the requisition number of
the deleted file.

Active levels one and three

Note If afile contains locked files/folders or is locked itself (dimmed on the
screen), it cannot be deleted. To unlock afile/folder (and enclosed files),
select the “ Secure” command in the “File€” menu.

This command will export the sign order list and the actual database referenced. Before
exporting, a dialog box will ask for the destination path of the exported file. The path may
include drive and directories (for example A:, C:\Export\, etc). Make sure your destination drive
ends with a colon (:) or backslash (V).

Active level one

Note Sign order lists that are exported to destinations containing files with identical
file names will be added to those sign order lists.

Imports external sign order lists and will add the referenced sign files to the sign Inventory.
Before importing, a dialog box will ask you for a source path to retrieve the sign order from
(for example A:, C\Export\, etc). It will then import the files and ask the quantity of signs you
would like to add.

Active level three

Note Make sure your destination drive ends with a colon (:) or backslash (V).

Prints the selected order as specified in the dialog box. To scan a sign order, you might want
to print out only a summary sheet or a one line description of each sign. A full print out of a
sign order contains all signsin the sign order list (if present in the database) and an order cover
page with a sign type summary listing the different sign typesin the order. If only one
fileffolder is present, it is automatically selected; otherwise the cursor will move inside the
window to choose afile. The file/folder will print asit is displayed on screen. Print
commands are:

Print -files: printsall records in the file/ffolder.
-summary: prints only a summary page of the filesin the sign order list.

Description -short: prints a one line summary of the sign specification.
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Secur e command

Data menu

All sorting commands

Transfer menu

Inventory command

Catalog command

-long: prints the entire specification of the sign.
Copies prints the specified number of printouts.

Active levels one and two

Note To choose print commands, move the cursor to the command with the <Tab> key
and use the <Up> or <Down> key to select the command selection. The
cover/summary page is the last page to print, since al filesin the sign list must be
processed and evaluated.

Locks or unlocks a selected file. If only one (1) fileffolder is present, it is automatically
selected, otherwise the cursor will move inside the window to choose a file. Used to prevent
accidenta erasure or modification. You may secure asingle file or folder or al files located
within the folder. Secured files/folders or files located in a secured folder cannot be edited,
deleted, or added to. To reverse the command, select the file/folder with the “ Secure”
command again.

-Data-----------------
By | D Nunber
By Sign Type

By Specification Code
By Sign Quantity

By Project

By Location

Controls the display of filesin the opened sign order list. Data can be sorted in ascending or
descending order and by the criteria as listed in the menu. Display of afileis“remembered” as
last specified and indicated in the menu with an arrow.

Active level three, sign order list

-Transfer ----------
I nvent ory
Cat al og

Speci fications
»Orders

Transfers control to the Inventory of the program. The files that have been modified last will
be opened and displayed in a window.

Active All leve

Note If the command is dimmed, you are currently in the selected program.

Transfers control to the Catalog of the program to select a sign type. When creating a new
sign and transferring from Inventory to Catalog, make sure you have selected a location to
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Specifications command

Orders command

System menu

Database command

Pause command <F9>

Quit command <F10 >

save the new sign into prior to transferring to the Catalog (transfer at level four or five). If
not, you will not be able to save a sign in the Specifications section later on.

Active All levds

Note If the command is dimmed, you are currently in the selected program.

Transfers control to the Specifications section of the program to select a specification file.
When creating a new sign and transferring from Inventory to Specifications section, make sure
you have selected a location to save the new sign into, prior to transferring to the
Specifications section (transfer at level four or five). If not, you will not be able to save a sign.
See the Specifications section of the program for more information on creating signs directly
through the Specifications section.

Active All levds

Note If the command is dimmed, you are currently in the selected program. The
easy way to enter anew sign is to first select a sign type in the Catalog, then
the correct specification file is accessed.

Transfers control to the Order section of the program to generate or modify an order.
Active In Inventory, Catalog, and Specifications.

Note If the command is dimmed, you are currently in the selected program

-- System ----
Dat abase

Pause

Quit

Selects the path to search for order files.
Active Always

Specifies the waiting time before the screen goes blank with the pause screen, displaying the
time. To return to normal execution, press any key.

Active All levds

Note To deactivate screen save, enter “0” minutes.
Pressing <F9>, activates pause screen, not the “Pause” command.

Exits program to DOS.

Active All levds
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Cener al

I nventory

Cat al og

Speci fications
O ders

General command <F1 > Transfers control temporarily to a general help program. The program contains information on

Inventory command

Catalog command

Specifications command

Order command

sign types and their hierarchy, material specification codes, color codes, error codes, and
diagrams for viewing distances and footings. While in the help program, you may switch to
other available help files by using the <PgUp> and <PgDn> keys.Active All levels

Transfers control temporarily to the Inventory help program. The program contains
information on commands and key words. While in the help program, you may switch to other
available help files by using the <PgUp> and <PgDn> keys.

Active All leves

Transfers control temporarily to the Catalog help program. The program contains information
on commands and key words. While in the help program, you may switch to other available
help files by using the <PgUp> and <PgDn> keys.

Active All levels

Transfers control temporarily to the Specifications help program. The program contains
information on commands and key words. While in the help program, you may switch to
other available help files by using the <PgUp> and <PgDn> keys.

Active All levels

Transfers control temporarily to the Order help program. The program contains information
on commands and key words. While in the help program, you may switch to other available

help files by using the <PgUp> and <PgDn> keys.

Active All levds
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Appendix A

Start program
installation

Floppy drive to
read from

Hard disk to
install on

Directory name

Help files

Swap disks

Prior to using the installation program, backup all the program disks supplied with the manual
and store the originals in adry, safe place.

Before running the installation utility program, verify the following default settings which will be
used when installing the program. If these settings are not correct or if you would like to use
different names, you can modify the entries when running the installation program.

- The floppy disk drive from which the disks are being read is disk drive “A:”
- The degtination hard drive to install the Sign Manager programs on is disk drive “C:”

- Directory name where Sign Manager programs will be located is “SM”

- Insert disk #4, “ Orders and Installation” disk in floppy disk drive“ A" and type

“ Al INSTALL”
The ingtallation utility will load and a diadlog box will appear asking if you would like to ingtall the
Sign Manager program.

- Press <Enter> to activate the “ Install” button, or press <Esc> to quit and return to DOS

- Type your floppy drive name “ A:” ( include the colon) and press<Enter>
The floppy drive will be verified.

- Type your hard disk drive name “ C:” (include the colon) and press <Enter>
The hard drive will be verified.

- Type your directory name “ SM” and press <Enter>
The directory will be verified.

A dialog box will appear asking if you would like to ingtdl the on-line help files. If you need
space on your hard drive and are familiar with the program, you may elect not to install these
files. T he program will perform perfectly without these additional help files.

- Press <Enter> to activate the “ Yes, Install” button, or select the “ No, Continue’ button
A dialog box will appear asking to insert disk #1, “Program”.

- First remove disk #4, “ Orders and installation” , then insert disk #1, “ Program” , and finally
press <Enter> to continue the installation

You will repeat this procedure with all other disks, until al files have been copied and the
message “Installation was succesfull” appears. After pressing <Enter> the program will return
command to DOS and you can activate the program by typing “SM” (or your own file name).



Appendix B

Alphabetic listing

Symbols are listed aphabetically and numericaly. Symbols may be found several timesin
the aphabetic listing, since a symbol can be listed as “Picnic Shelter” and “ Shelter, Picnic”.

Symbol

All-Terrain Vehicle Trall
Amphitheater
Automobiles

Baseball

Bicycle Trail

Boat Tour

Bus Stop

Campfires Permitted
Campground
Canoeing

Cleaning, Fish

Cross Country Skiing
Dam

Deer Viewing

Diving

Diving, Scuba
Drinking Water
Dumepster, Trash

Environmental Study Area

Exercise Fitness Area
Falling Rocks

Ferry, Vehicle

Fire Extinguisher

Firg Aid

Fish Cleaning

Fish Hatchery

Fish Ladder

Fishing Area

Fishing, Ice

Fitness Area, Exercise
Food Service/Restaurant
Gas Station

Grocery Store
Handicapped
Hatchery, Fish

Hiking Trall

Number
RS-095
RS-070
RS-003
RS-096
RS-066
RS-087
RS-031
RS-042
RS-038
RS-079
RS-093
RS-046
RS-009
RS-011
RS-062
RS-060
RS-013
RS-091
RS-076
RS-097
RS-008
RS-033
RS-090
RS-024
RS-093
RS-010
RS-089
RS-063
RS-092
RS-097
RS-019
RS-005
RS-020
RS-028
RS-010
RS-068

Symbol

Horse Traill

Hunting

Ice Fishing

Ice Skating
Information

Kennd

Ladder Fish
Launching Ramp
Laundry

Lifejackets
Lighthouse

Litter Receptacle
Lodging

Lookout Tower
Marina

Men’'s Restroom
Motor Bike Trail
Motorboating
Off-Road Vehicle Frall
Parking

Pedestrian Crossing
Pet on leash Permitted
Picnic Shelter

Picnic Site
Playground

Point of Interest
Post Office

Ramp, Launching
Ranger Station
Rattlesnake
Receptacle, Litter
Recreation, Winter
Restaurant/Food Service
Restroom, Men’s
Restroom, Women's
Restrooms

Number
RS-064
RS-072
RS-092
RS-050
RS-014
RS-045
RS-089
RS-054
RS-085
RS-094
RS-007
RS-086
RS-018
RS-006
RS-053
RS-021
RS-065
RS-055
RS-067
RS-034
RS-016
RS-017
RS-039
RS-044
RS-069
RS-080
RS-026
RS-054
RS-015
RS-099
RS-086
RS-077
RS-019
RS-021
RS-023
RS-022



Alphabetic listing Symbol Number Symbol Number

continued Rocks, Faling RS-008 Four Boat RS-087
Rowboating RS-057 Tower, Lookout RS-006
Sailing RS-056 Trail Shelter RS-043
Sanitary Station, Trailer RS-041 Trail, All-Terrain Vehicle RS-095
Scuba Diving RS-060 Trail, Bicycle RS-066
Shelter, Picnic RS-039 Trall, Hiking RS-068
Shelter, Sleeping RS-037 Trail, Horse RS-064
Shelter, Trail RS-043 Trail, Motor Bike RS-065
Showers RS-035 Trail, Off-Road Vehicle RS-067
Site, Picnic RS-044 Trailer Sanitary Station RS-041
Site, Trailer RS-040 Trailer Sites RS-040
Skateboard RS-098 Trash Dumpster RS-091
Skating, Ice RS-050 Trucks RS-004
Skiing, Cross Country RS-046 Tunnel RS-032
Sledding RS-049 Vehicle| Ferry RS-033
Sleeping Shelter RS-037 Viewing Area RS-036
Smoking RS-002 Viewing, Deer RS-011
Snack Bar RS-1 ()2 Wading RS-088
Snowshoeing RS-078 Water, Drinking RS-013
Snowmohiling RS-052 Waterskiing RS-058
Store, Grocery RS-020 Winter Recreation RS-077
Swimming RS-061 Women’'s Restroom RS-023
Telephone RS-025

Numeric listing Smoking RS-002 Pet on leash Permitted RS-017
Automoabiles RS-003 Lodging RS-018
Trucks RS-004 Restaurant/Food Service RS-019
Gas Station RS-005 Grocery Store RS-020
Lookout Tower RS-006 Men's Restroom RS-021
Lighthouse RS-007 Restrooms RS-022
Falling Rocks RS-008 Women's Restroom RS-023
Dam RS-009 First Aid RS-024
Fish Hatchery RS-010 Telephone RS-025
Deer Viewing RS-011 Post Office RS-026
Drinking Water RS-013 Handicapped RS-028
Information RS-014 Bus Stop RS-031
Ranger Station RS-015 Tunnel RS-032
Pedestrian Crossing RS-016 Vehicle Ferry RS-033



Numeric listing

Symbol

Parking

Showers

Viewing Area
Sleeping Shelter
Campground

Picnic Shelter

Trailer Sites

Trailer Sanitary Station
Campfires Permitted
Trail Shelter

Picnic Site

Kennd

Cross Country Skiing
Skiing, Cross Country
Sledding

I ce Skating
Snowmobiling

Marina

Launching Ramp
Motorboating

Sailing

Rowboating
Waterskiing

Scuba Diving
Swimming

Diving

Fishing Area

Horse Trail

Motor Bike Trall
Bicycle Trail
Off-Road Vehicle Trall
Hiking Trail
Playground
Amphitheater

Hunting
Environmental Study Area
Winter Recreation
Snowshoeing
Canoeing

Number
RS-034
RS-035
RS-036
RS-037
RS-038
RS-039
RS-040
RS-041
RS-042
RS-043
RS-044
RS-045
RS-046
RS-046
RS-049
RS-050
RS-052
RS-()53
RS-054
RS-055
RS-056
RS-057
RS-058
RS-060
RS-061
RS-062
RS-063
RS-064
RS-065
RS-066
RS-067
RS-068
RS-069
RS-070
RS-072
RS-076
RS-077
RS-078
RS-079

Symbol

Point of Interest
Laundry

Litter Receptacle
Tour Boat
Wading

Fish Ladder

Fire Extinguisher
Trash Dumpster
Ice Fishing
Cleaning, Fish
Fish Cleaning
Lifejackets

All-Terrain Vehicle

Trail

Basebdl
Exercise Fitness
Area
Skateboard
Rattlesnake
Snack Bar

Number
RS-080
RS-085
RS-086
RS-087
RS-088
RS-089
RS-090
RS-091
RS-092
RS-093
RS-093
RS-094
RS-095
RS-096
RS-097
RS-098
RS-099
RS- 102



Appendix C

DRSS-O, APRDIR,
APRS-O, PRIDIR

SAF-CS, SNO-CS,
SDA CS, SWA-CS

BTR-O1

ENT-02

SLATCS

Some signs in the database need special treatment to obtain correct calculations, sizes, etc.
All these sign have been listed below with specia instructions for each particular problem.

Directional sign legend with “ Direction Identifers’

Directional sign legends must be entered using “Direction Identifiers’. The identifier tells the
program how to calculate the correct panel size. If not entered properly, an improper panel
Size, post size and quantity may be calculated.

Procedure: First, enter the identifier using plus (+) and minus (-) keys while the message box
is shown, then enter the sign message. DO NOT leave empty lines between messages.
Identifers are:

- Message with arrow right
- Message with arrow right 45°
- Message with arrow left

- Message with arrow left 45° ~ Message with arrow straight up
- Next message

Custom industrial safety with fifth legend line

Default setting is “grid A” (four lines). To change to five legend lines, change the grid
format to “grid B”". Keep in mind that this will aso change the capital legend size from 1A to
.833A and thus decrease the viewing distance of the sign.

Sgn panel size

The default setup for the BTR-01.SPC specification file includes al optional legends as listed
on page 7.23 of the sign manual. You may delete and edit any of the optional messagesin
the “Message” section of the specification file. The program will automatically calculate the
correct panel size.

Sgn panel size

The default setup for the ENT-02.SPC specification file includes all optional legends as listed
on page 7.5 of the sign manual. You may delete, add, and edit any of the optional messages
in the “Message” section of the specification file. After entering the message you will be
asked to supply the number of added optional messages. This refers to both one- and
two-line messages. The program will then automatically calculate the correct panel size.

Custom dat sign legend lengths

Since the amount of information necessary for a slat sign panel does not alow for calculation
of custom sign legends, a calculating mechanism is provided with a custom dlat sign
specification file (SLATCS.SPC). If you are not sure whether or not a custom legend might
fit on a dat, activate the specification file by selecting “Load” from the “File” menu and
select “SLATCS’. The specification file will load and you can enter your custom legend in
the first two lines of the “Message” section. If the legend istoo long, a“Line overflow”
error message will appear.



Appendix D

[E] Data entry
errors

File error codes are listed below with a description of the error and possible cause of the

error.

[E] refersto an error in data entry. [F] refers to an error in file input/output. [S] refersto a
system or internal error. Always make sure you have a backup of your database to prevent

loss of data.

[E1] Invalid path name: “ Path Name”
Wrong path name was specified. Path must
address an existing drive and end with a colon
(:) or backslash (\).

[E2] Please use 00-00-0000 date format
Incorrect date format was entered.

[E3] Invalid range of ID numbers
Overlapping range of humbers was specified.

[E4] Invalid number of copies
Number of copies must be larger than 0.

[E5] Value must be equal to O, or larger than
0.5 minutes

0 minutes will deactivate the screen save,
otherwise the time interval must be larger than
0.5 minutes.

[E6] Invalid file name: “ File Name’
File name must consist of apha numeric
characters with a maximum of eight (no
spaces).

[E7] Duplicate project: "Project Name”
District cannot contain identical project
names. Rename the new project.

[E8] Duplicate file name: “ File Name”
District cannot contain identical project file
names. Rename the new project file name.

[E9] Invalid code name: “ Code Name’
File name must consist of apha numeric
characters with a maximum of three (no
spaces alowed).

[E10] Duplicate location: “ Location Name”
Project cannot contain identical location
names. Rename the new location.

[E11] Duplicate file code: “ File Code”
Project cannot contain identical location
file names. Rename the new location file
name.

[E12] Value must be larger than O
Sign ID number must be larger than 0 and
smaller than 999.

[E13] Duplicate sign ID code: “ Sgn ID
Code”

Location cannot contain identical 11)
numbers. Rename the new 11) file.

[E14] Cannot delete file\order, protected
file was found

To execute the command, “Unlock” the
enclosed files using the “ Secure”
command in the “File” menu.

[E15] No print overview on this level
Print overview of afolder isonly available
at level one to three of the Inventory.

[E16] No blank entry
A valid entry must be made in the field.

[EL17] Tried to import a file with a
duplicate code: “ Code Name” , please
rename

Database cannot contain identical file
names. Rename the new file.

[E18] Duplicate order: “ Order Number”
Database cannot contain identical order
files. Rename the new order file.

[E19] Quantity must be larger than O
Quantity of an ordered sign must be larger
than 0.



[E] Data entry errors

[F] Fileinput/output
errors

[E20] Duplicate project name: “Project Name”
Database cannot contain identical order files.
Rename the new file.

[E21] Cannot add to list; duplicate record
was found

Sign order list cannot contain identical files.
The file will be skipped.

[E22] Value must be between 0 and 48 inches
Capitd letter height must be between indicated
sizes.

[E23] Value must be between 0 and 999 feet
Viewing distance ranges from 0 to 999 feet.

[E24] Cannot clear, first line is locked
Directional sign messages always start with an
identifier.

[E25] Thislineis locked
The specification file will not alow this legend
line to be modified.

[E26] Trailing space found after line "X"
While editing the message, you have created a
line with trailing space(s). Since these spaces
are calculated, it is necessary to remove them
before entering the message. Move to the end
of the line “x” and press <Delete> to remove
the space. You will seethe line legend size of
line “x” diminish. Repeat until al trailing
spaces have been removed (line legend size
will remain the same when deleting).

[F1] Fileislocked

Command can not be executed since thefile
or folder islocked. Use “Secure’ in the “File’
menu to unlock the file.

[F2] File SMHELP.EXE is missing
Help file is not properly installed or is not
located in the same directory as the program.

[F3] Paste on level "X, not level “y”

Copy and paste commands must be used on
the same level (x and y).

[F4] Cannot overwrite origin, please change
path

[E27[ Previous line already identified,
please enter message
A message can only be identified once.

[E28] Can only identify the first line,
please enter message

DRSS-3 and DRSS-4 must have an
identifier on the first line.

[E29] End of line; 38 characters only
Legend line can only contain 38
characters.

[E30] Cannot calculate panel size; not all
legends entered

For proper calculation of sizes, dl legends
must be entered properly.

[E31] Line overflow

Sign type grid will not allow entry of more
information on this line. Use next line to
continue the message.

[E32] Line overflow when using grid A;
switch to grid B

Sign type grid will not allow entry of more
information on thisline. Use next line to
continue the message or change the grid
format to reduce the line length.

Database cannot be pasted over itself. To
paste a new database, change the path
name.

[F5] Tried to paste project with duplicate
file name; please rename

Database cannot contain file names.
Rename the new file.



[F] Fileinput/output
errors

[S] System/internal
errors

[F6] Path\file not found
Tried to open non-existing file or file with a
bad name.

[F7] File* File Name” .SPC not found
Specification file is missing. Make surethe
correct database path is specified for the
specification files.

[S1] Out of memory Program istoo large Do
not use additional programs (automenu,
screensave, etc.)

[S2] Out of string space
String variables exceed the amount of free
memory remaining.

[S3] Device timeout

Did not receive information from an
Input/Output device within a predetermined
amount of time.

[4] Device fault
Indicates a hardware error.

[SB] Out of paper
The printer is out of paper or, a printer fault.

[ 6] Bad file name or number

A statement or command references afile
with afile number that is not open or is out of
range of file numbers specified at initidization.

[S7] File not found
References a file that does not exist on the
current diskette.

[8] Bad file mode

[S9] File already open

A sequential output mode “Open” isissued for
afilethat is aready open, or a“Kill” is given
for afile that is open.

[S10] Device input/output error
Usualy adisk 1/0 error.

[F8] File“ File Name” is damaged;
cannot load

Specification file has been damaged or
modified. Replace with new file.

[SLI] File already exists
The file name specified isidentical to afile
name aready in use on the diskette.

[S12] Diskisfull
All disk storage spaceis in use.

[93] Bad file name
An illegal form isused for the file name.

[S14] Too many files
An attempt is made to create a new file
when all directory entries are full.

[95] Disk not ready
Occurs when the diskette drive door is
open or adiskette is not in the drive.

[S16] Disk media error
Diskette controller detected a hardware
fault.

[S17] Path/file access error
MS-DOS is unable to make a correct
path-to-file name connection. The
operation is not completed.

[S18] Path not found
MS-DOS is unable to find the path
specified. The operation is not completed.

[S19] Unknown internal error: “ Code”
Error message for alerting internal
software execution errors.

[S20] Invalid serial number
Check master diskette for the correct
number.



Appendix E

Identification

Directional

Recreation

Listed below is the sign hierarchy as it is used in the sign catalog with the exception of
DRSS-0 (symbol directiona) which is listed under “Directiona”. To select a particular sign
type follow the category selections from left to right.

STANID; Main ID
SECNID; Secondary ID
CREDIT, Credit Sign

APRDIR; Approach Roadway
APRS-0; Approach & Symbol

PRJDIR; Project Directional
DRSS-0; Symbol Directional

HRS-00; Hours Sign

ENT-00; Entrance Signs
CMP-00; Campground Signs
PI C-00; Picnic Area Signs
SWM-00; Swim Area Signs
BTR-00; Boat Ramp Sign
UNS-00; Undesignated safety
TR-000; Trail Markers
Symbols

CST-00; Custom Recreation

APRS-3; Three Symbols
APRS-4; Four Symbols

DRSS-1; One Symbol
DRSS-2; Two Symbols
DRSS-3; Three Symbols
DRSS-4; Four Symbols

HRS-14/17; Inserts
HRS-01/08; Format A
HRS-09/13; Format B

RS-000; Identification Sign
AC-000; Handicapped Sign
PS-000; Prohibition Sign
SLAT-0; Slat Sign SLAT-1; Replacement Slat
SLAT-2; Two Slats
SLAT-3; Three Slats
SLAT-4; Four Slats
CST-01; grid |

CST-02; grid 2

CST-03; grid 3



Traffic

Boundary

Industrial Safety

Regulatory

Office Interior

Non Corps

R00-00; Regulatory
WO00-00; Warning
PRK-00; Parking
NPK-00; No Parking

BLM-01 /03; Property Markers
BL M-04/06; Wildlife Management Area Markers

SDA-00; Danger
SCA-00; Caution
SAF-00; Safety
SNO-00; Notice
SDR-00; Directional

REC-001; Title 36

Directory INT-01/02; One/two column grid
Registry INT-03/04; One/two column grid
Directiona INT-05; Large Ceiling

INT-06; Smdl Ceiling
INT-07; Wall mounted

I dentification INT-08; Cube
INT-09; Office
INT-12; Employee
INT-10; Information
INT-11; Safety

NONCRP; All non-standard signs



